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General

a.

If Customer is the United States Government, the following paragraph shall apply: All Nortel Networks
Software available under this License Agreement is commercial computer software and commercial
computer software documentation and, in the event Software is licensed for or on behalf of the United States
Government, the respective rights to the software and software documentation are governed by Nortel
Networks standard commercial license in accordance with U.S. Federal Regulations at 48 C.F.R. Sections
12.212 (for non-DoD entities) and 48 C.F.R. 227.7202 (for DoD entities).

Customer may terminate the license at any time. Nortel Networks may terminate the license if Customer
fails to comply with the terms and conditions of this license. In either event, upon termination, Customer
must either return the Software to Nortel Networks or certify its destruction.

Customer is responsible for payment of any taxes, including personal property taxes, resulting from
Customer’s use of the Software. Customer agrees to comply with all applicable laws including all applicable
export and import laws and regulations.

Neither party may bring an action, regardless of form, more than two years after the cause of the action
arose.

The terms and conditions of this License Agreement form the complete and exclusive agreement between
Customer and Nortel Networks.

This License Agreement is governed by the laws of the country in which Customer acquires the Software. If
the Software is acquired in the United States, then this License Agreement is governed by the laws of the
state of New York.

314470-15.7 Rev 00



Contents

Preface
Tt (o] £ I (o TU =TT 1o SRR Xviii
TEXE CONVENLIONS ..oiiiiiiiiie ettt et e e e e s ee e e e et be e e e e s st aeeeeesnsreeeeeennsees XiX
o 0] ) 0 RSP XX
Hard-Copy Technical ManUALIS ...........cocueioiiiiiiie et XXii
HOW 10 QT NEID e XXii
Getting help from the Nortel Web Site ........ccooiiiiiiiiii e XXii
Getting help over the phone from a Nortel Solutions Center ..........cccccoevvieeeennnnen. XXiii
Getting help from a specialist by using an Express Routing Code ............cc.cc....... XXiii
Getting help through a Nortel distributor or reseller ........c.coccceiiiiiiiiiii e, XXiii
Chapter 1
BayRS Online Library CD
Accessing Nortel Networks Documentation onthe Web .........cccocooiiii 1-1
Chapter 2
Configuring and Managing Routers with Site Manager
VErSION 15.3.0.0 .oeoiiiiiiiiie e 2-1
Changing the Trap Port for Multiple Network Management Applications ................. 2-1
Chapter 3
Configuring ATM Services
VErSION 15.2.0.0 .ooiiiiiiiiiie et 3-1
Creating an ATM Circuit for a T3 or E3 Connection on a Passport 5430 ................. 3-1
Specifying the Cable LENGLh .......c.uoiiiii e 3-2
Specifying the Clear Alarm Threshold ..o 3-2
Specifying the Line Coding Method ...........coooiiiiiiiiiiiiiiiee e 3-3
Specifying the LINe TYPE ...coiueieiiiieiiee et 3-3
Specifying the Loopback MOdE ...........ocuiiiiiiiiiiiiee e 3-3
Defining the Interface MTU ... 3-4

314470-15.7 Rev 00 v



Defining the Primary CIOCK SOUICE .........coiiiiiiiiiiiiiiee e 3-4

Specifying the Setup Alarm Threshold ..., 3-5
Disabling and Reenabling the ATM interface .........ccccceeiviiiien i 3-5
VEISION 15.3.0.0 oottt e e e e e e et e et e e e e e e e e e e e nanr e eeeeeaaaeaeeaaaana 3-8
Defining the SVC Inactivity TIMEOUL ..........eiiiiiiiiiieii e 3-8
Defining the Clocking Signal SOUICE ..........coiiiiiiiiiiiiee e 3-10
VErSION 15.5.0.0 .oeiiiiiiiiii e 3-11
Turning DS-3 and E3 Cell Scrambling On and Off .........ccoociiiiiiiiieee e, 3-11
VErSION 15.6.0.0 .oeeiiiiiiii e 3-12
Virtual Circuit Monitoring with the ifSpeed MIB Attribute ...........ccocoeiiiiiiiennenn. 3-12
Chapter 4
Configuring Bridging Services
VErSION 15.2.0.0 .ooiiiiiiiiiie et 4-1
INterfaces SUPPOITEA ........oiiiiiieiie et e s smae e 4-1
VErSION 15.5.0.0 .ooiiiiiiiiiii et 4-1
Specifying the IP Network Ring ID for the Source Routing Bridge ...........cccceevueenee. 4-2
Chapter 5
Configuring Data Compression Services
VErSiON 15.5.0.0 ..ooiiiiiiiiiie et 5-1
Hi/fn LZS Compression for Passport 2430 and Passport 5430 .........ccccoceeeiiieenne 5-1
VErSION 15.6.0.0 ..ooiiiiiiiiiie e 5-2
IP Payload Compression over GRE TUNNEIS .........cooceiiiiiiiiiiiciee e 5-2
How IP Payload Compression Is AccompliShed ..........ccoovvieiiiiiiiiiniesee e 5-3
Implementation NOTES .........ooo i e 5-3
Configuring IP Payload COMPIreSSION ......cccoiiiiiiiieiiiiiiee e 5-5
Displaying Statistics for IP Payload Compression .........cccccceveeeinieeiiiiensnieenne 5-6
Hi/fn LZS Compression for BN Routers with FRE-4-PPC Modules ................... 5-7
Chapter 6
Configuring Differentiated Services
VEISION 15.1.0.0 ooiiiiiiiii ettt e e e e e et e e e e e e e e e e e e e s e nnnrreneeeeaaaeaeeaaannas 6-1
Modifying RED Parameters .........occuueiiiiiiiiieie ettt 6-1
VEISION 15.2.0.0 oiiiiiiiiie ettt et e e e e e e ettt e e e e e e e e e e e e nanerereeeeaaaaaeeaaanna 6-2
e ToT 41 AV = U=V 0 0= (= 6-2

Vi 314470-15.7 Rev 00



RV 2T <1 (o] T ST 75O I O 6-2

IMplementation NOTES ..........eiiiiii e 6-2
VErSION 15.4.0.0 ..ooiiiiiiiie et 6-3
IMplementation NOTES ..........oiiiiiii e 6-3
VErSION 15.5.0.0 ..oiiiiiiiiiiie et 6-5
DSCP Tagging for Router-Generated Packets ...........cccovieeiniiiiniiiieeee e 6-5
DSCP Tagging of ICMP, SNMP, and Telnet Packets .........ccccccoviiiieeiiiiieneenee 6-7
DSCP Tagging of IPSeC Packets ..........cceoiiiiiiiiiiiiii e 6-7
Mapping of Router-Generated Packets to DSQMS Queues .........ccccoccveeeeennnee 6-8
BCC show Command Enhancement ..........cccooouiiiiiiiiiiei e 6-10
Show dSgMS QUEUES STALS .....uiiiiiiiie i 6-10
Interoperability of Protocol Prioritization (Priority Queuing) and DSQMS .............. 6-11
VErSION 15.6.0.0 .oeiiiiiiiiie et 6-12
Mapping of Router-Generated Protocol Packets to DSCPS .........cccccevevviciieeeeeennee. 6-12
Interoperability of Protocol Prioritization and DSQMS ..o, 6-13
Using Site Manager to Configure DSQMS .........ccciiiiiiiiiiiee e 6-14
DSQMS Configuration StEPS ........ccceeeriiieriiie e 6-15
Enabling DSQMS on an INterface ..........ccooueieiieiiiieeeee e 6-15
Creating RED Instances for Use by Traffic Classifiers .........ccccooiieeiiiiiincnns 6-16
Creating DSQMS Queues and Associated Traffic Classifiers ..........cccccoceenee. 6-16
Modifying RED Parameters ..o 6-18
Modifying DSQMS Interface Parameters ..........ccccoovieeiiiiiiniii e 6-19
Modifying DSQMS QUEUES .......ooiiiiiiiiiiieeieee e 6-20
Chapter 7
Configuring DLSw Services
VErsion 15.5.0.0 ..o e 7-1
DLSW Protocol PrioritiZatioN ..........ccooiieiiiiiiciiiicisiiee e 7-1
Configuring DLSw Protocol Prioritization using the BCC .........ccccoiiiiiiiiiiiceeeee 7-2
Configuring and Enabling Global Parameters for DLSw Protocol Prioritization ....... 7-2
Customizing Global Parameters for DLSw Protocol Prioritization ..................... 7-2
max-queue-buffers-unconfig-PEErS .........coui i 7-2
Max-quUeue-Size-UNCONTIG-PEEIS ......coiiuiiiieiiiiiie e 7-3
default-bandWidth ... 7-3
Enabling and Disabling DLSw Protocol Prioritization for Peers ...........ccccccuu..... 7-4
314470-15.7 Rev 00

Vii



Customizing and Enabling DLSw Priority Queues for Specific Peers .............c........ 7-5

Specifying a Peer for Custom DLSw Priority Queue Configuration ................... 7-5
Customizing the DLSw Priority Queues for a Specific Peer .........cccccoecieveennnee 7-6
Enabling and Disabling a Peer's DLSw Priority QUEUES ..........covevviviiireeinnneenn. 7-8
Creating and Enabling Priority Outbound Filters for DLSw traffic ...........ccccceennneee. 7-8
Enabling and Disabling DLSw Outbound Filters ..........ccccovoiiiiiiiiiiie e 7-9
Specifying Match Criteria for DLSw Priority Outbound Filters ...........ccccceeene 7-10
Specifying the Action for DLSw Priority Outbound Filters .........ccccocoieiinnnne 7-12
Chapter 8
Configuring Ethernet, FDDI, and Token Ring Services

VErSION 15.4.0.0 ..ooiiiieiiie e 8-1
Router Processing of Tagged Frames ... 8-1
Implementation ConSIAErations .........ccccuvviiiiiiiie e 8-2
Adding a Tagged Circuit to an Unconfigured 10BASE-T or 100BASE-T Interface ..8-4
Adding a Tagged Circuit to an Existing 10BASE-T or 100BASE-T Interface ........... 8-5
VEISION 15.5.0.0 1oiiiiiiiiie ettt e e e e e e e et e et e e e e e e e e e e e n e e eeeeeaaaaaeaaaanna 8-7
Implementation Note for the ARN ROULEr ......ccooiiiiiiiiiieee e 8-7
VEISION 15.6.0.0 oiiiiiiiiiei ettt e e e e e e e et e et e e e e e e e e e e e e nnanrreneeeeaaaaaeaaaaana 8-8
Using the BCC to Configure 802.1Q Tagged CirCUitS ........ccocovirieviriieeeniiee e 8-8
Adding a Tagged Circuit to a 10BASE-T or 100BASE-T Interface .................... 8-8

Editing a Tagged CirCUIt ........ooeeiieeiiei e 8-10
Disabling a Tagged CirCUIt ..........cooiuiiiiiiie e 8-10
Deleting a Tagged CirCUIt ......coocuiiiiiiiiiee e 8-11
Displaying Information about Tagged CirCuitS .........ccccoviiiiiiieniiiieiiee e 8-11

VEISION 15.7.0.0 oot s 8-13
DSQMS Rate Limiting on an Ethernet Interface ... 8-13
DSQMS Line Speed settings following upgrade to BayRS 15.7 ........ccccvveenee 8-13

Uses for rate MItING .....oooveeieii e 8-14

RANGE Of VAIUES .....eeeiiiiiiiiee e 8-14

How Rate Limiting WOIKS ..o 8-15
Configuring DSQMS liN€ SPEET ........evviiiiiiiieieiee e 8-15

viii 314470-15.7 Rev 00



Chapter 9
Configuring Frame Relay Services

R L= 7T o T T T L0 X O PSSR 9-1
Using Traffic Shaping — Site Manager .........cccoveiiiiiiiiie e 9-1
BT 7T o T T2 0 X 0 PRSI 9-2
Deleting PVCs from Service RECOIAS .........cocuiiiiiiiiiiiieiieeeriee e 9-2
BT 7T o T T 0 X O PSSR 9-3
Virtual Circuit Monitoring with the ifSpeed MIB Attribute ...........cccocoeiiiiiiiiiiciiiees 9-3
Frame Relay Traffic Shaping with DSQMS .........ccooiiiiiiii e 9-5
Configuration PrerequUISItES .......c.eviiiieieiiiiieiieeee e 9-6
Implementation Note: Configuring the Packet Limit for Queues ........................ 9-7
BCC show Command Enhancement ............ccooeiiiiiiiiieiiiic e 9-7
New Technician Interface SCrHPt ......oooiiiiiiii e 9-8
New MIB for Monitoring DSQMS at the PVC Level .......ccccccveeviiiiieeiiiiieee e 9-8
Configuring FRF.9 COMPIESSION ......ueiiiiiiiiiiie ettt 9-9
Implementation of FRF.9 Compression on BayRS Routers ............ccccceeeenneee. 9-10
Configuration ConSIderations ..........ccooiueieiiiiiiiie e 9-10
FRF.9, FRFE.12, and Traffic Shaping .........cccccooeiiiiiiiieeiiiee e 9-11
Configuring FRF.9 COMPIESSION ....ccoiiiiiiiiiiiiiiieee ettt 9-12
Configuring FRF.12 Fragmentation and Interleaving ..........ccccceeiiiiniiieniiieiiiees 9-15
Overview of FRF.12 Fragmentation and Interleaving ...........ccccooiiieiiiiiiienennnns 9-15
Configuring FRF.12 Fragmentation and Interleaving .........cccccovieeiiiiinineennn 9-19
Chapter 10
Configuring GRE, NAT, RIPSO, and BFE Services
VErSION 15.5.0.0 .ooiiiiiiiiii e 10-1
Configuring GRE Keepalive Functionality ............cccoiiiiiiiiniiiiiee e 10-1
Enabling and Disabling GRE Keepalive Messages for a Remote Tunnel End Point 10-2
Setting the Timeout Interval for GRE Keepalive Messages ..........ccccoeveeiiieneniennns 10-3
Setting the Keepalive Retries Parameter for GRE Keepalive Messages ............... 10-5
Chapter 11
Configuring IP, ARP, RARP, RIP, and OSPF Services
VErsion 15.3.0.0 ..o e s 11-1
[l O 72 SIS 0T o] o o] o AR 11-1
VEISION 15.4.0.0 oiiiiiiii ettt e e e oo e ettt e e e e e e e e e e e e e anbbeeeeeeeaaaeeeaaannn 11-2
Defining BGP Peers for BGP, OSPF, and RIP Announce Policies ..........cccccceene.e. 11-2

314470-15.7 Rev 00



IMPOrting RIP UPAAtES ......oeeiiiiiiiiiiiie et 11-2

MIB ODJECE IDS ...ttt ettt ettt st e e bt e e s be e e ene e e s neeeeaneeeans 11-4
VErSiON 15.5.0.0 .ooriiiiiiiii e 11-5
Enabling and Disabling Unique Identifiers for ICMP Echo Requests ..................... 11-5
RFC 3101 Forwarding Address Compatibility for OSPF NSSA ........cccoeeiiiinenn. 11-7
Enabling and Disabling RFC 3101 Forwarding Address Compatibility ............ 11-8
Configuring the Not-So-Stubby Area (NSSA) Forwarding Address ................. 11-9
VEISION 15.7.0.0 oeiiiiiiiiiiee ettt e et e e e e e e e an e e e e e e 11-11
Monitoring Circuitless IP using SNMP ... 11-11
Configuring and Enabling OSPF MD5 Authentication ............cccceviieeiiiiiiiieeene. 11-14
How OSPF MDF5 authentication WOrkS .........c.ccveiiiiiiiiiciiiei e 11-14
Entering and Storing MD5 Authentication Keys .......cccccccoveeiiiiiiniee e 11-15
Generating MD5 Signatures on Transmitted OSPF Packets ..........ccccccceeeenn. 11-15
Verifying MD5 Signatures on Received OSPF Packets ..........ccccocveviienene. 11-16
Configuring OSPF MD5 authentication ...........cccccoviiiiiiiiiiiieiee e, 11-16
Configuring OSPF MD5 authentication using Tl Secure Shell ...................... 11-17
Configuring OSPF MD5 authentication using the BCC ........c.coocoieiiiiiiiennn. 11-23
Configuring MD5 authentication using Site Manager ..........ccccocveeiieniieens 11-28
Documentation ChanQEs .........ccuueiieiiiiiiee e 11-32
Chapter 12
Configuring IP Utilities
VEISION 15.7.0.0 .oeiiiiiiiiiii et 12-1
Secure Shell and Secure FTP SErviCes .........cccoviiiiiiiiiiiiiieiieee e 12-1
Overview of SSH and SFTP Configuration Requirements ..........ccccccceevceeennee. 12-3
Configuring kseed using Secure Shell ... 12-5
Configuring SSH and SFTP SEerViCEeS .......cccouieiiiiiiiiie e 12-6
Supported SFTP Commands .......cococciiiiiiiiieeeee e 12-12
Show COMMANGAS .....eiiiiiiie ittt st e e n 12-12
Logging on t0 SSH SEIrVEN ....cooiviiiii e 12-13
Site Manager Parameters ........ooceoiiiiiiiiie e 12-17
Chapter 13
Configuring IP Exterior Gateway Protocols (BGP and EGP)
VErSION 15.5.0.0 .ooiiiiiiiiie e 13-1
BGP Implementation NOTES ........ccueiiiiiiiiiie e 13-1

X 314470-15.7 Rev 00



Chapter 14
Configuring IP Multicasting and Multimedia Services

BT 7T T T2 0 X 0 SRR 14-1
Configuring a PIM Bootstrap Border ROULEN ...........coociiiiiiiiiiiieiiee e 14-1
VEISION 15.6.0.0 .ooiiiiiiiiiiiie et e e e e e e e e e et e e e e e e e e e ee e s anneeeereeeeeeeeeanannn 14-2
Overview of IGMP Version 3 and PIM-SSM .........ccccooiiiiiiiiiiiiieieee e 14-2
How BayRS Implements SSM .......cooiiiiiiiiiii e 14-3
REFEIENCES ... e 14-4
Starting IGMP Version 3 and PIM-SSM ... 14-5
Adding IGMP Version 3 and PIM-SSM to the Router ..........c.ccccoviviiiiiiiiinenns 14-5
Editing IGMP and PIM Parameters for PIM-SSM .........ccccciiiiiiiiiniieceee, 14-7
Customizing IGMP Version 3 and PIM-SSM ........ccccooiiiiiiiiiiieee e 14-9
Disabling and Reenabling PIM-SSM ... 14-9
Configuring Equal-Cost Multipath Support for PIM-SSM ..........ccccccviiiiiienen. 14-10
Configuring PIM-SSM Address Ranges ........cccceeeviiiiiiieiiiiieeee e 14-12
Editing IGMP Interface Fine-tuning Parameters ..........ccccoooeiiiinec e, 14-13
Configuring the PIM-SM/PIM-SSM Translation Table ...........cccccoviiiiiiiiiiiennnns 14-15
Configuring Static RP Routers for PIM-SM ..........cccciiiiiiiiiieee e 14-17
Chapter 15
Configuring PPP Services
VEISION 15.5.0.0 1oiiiiiiiiiiie e e e e e e e e e e e r e e e e e e e e e e e e reeeaeeeeeeaaannn 15-1
Multi-Class Extension to Multi-Link PPP ........c.ooiiiiiiii e 15-1
Enabling and Disabling Multilink Multiclass on Interfaces ...........ccccooiiiiiiiniinnnn. 15-3
Specifying the Fragment Size for PPP Multilink Classes ..........cccocoevviiiiiiieienieens 15-5
Enabling and Disabling Multilink Multiclass on Dial-up Lines .........ccccccvveeeveeeennnnn. 15-7
VErSION 15.6.0.0 oiiiiiiii ettt e et e e e e e e e e e e e e e e e e e e eeaaae e e e annn 15-9
PPP Link Quality Monitoring and Reporting for HSSI Interfaces ...........cccccovieenne 15-9
Chapter 16
Configuring RADIUS
VErsion 15.2.0.0 ..o e 16-1
Configuring a RADIUS Client Using Site Manager ...........cccoceeeeviiiieee e 16-1
Modifying Router Access Using the BCC or Site Manager ..........ccccoecveeiiieienneenne 16-2
USEIr/MaNAgEr LOCK .....coiiiiiiee ittt e 16-2
LOGIN ACCOUNTING ..ttt 16-4
Using SecurlD for RADIUS Authentication ...........ccoooiiiiiiiiiiee e 16-5

314470-15.7 Rev 00

Xi



Chapter 17
Configuring Traffic Filters and Protocol Prioritization

VEISION 15.4.0.0 ooiiiii it e e e e e e e e e e et e e e e e e e e e ee e e nnneerareeaaeeeeeanannn 17-1
Configuring IP Outbound Traffic Filters Using the BCC .........cccooiiiiiiiiiiieiiees 17-1
Configuring Protocol Prioritization ... 17-2
Customizing Protocol Prioritization ...........c.cccceeiieiiniiiniieeeiee e 17-3
Creating Outbound Traffic Filters ... 17-8
Chapter 18
Configuring VRRP Services
VErSION 15.3.0.0 .oeiiiiiiiiiiie et 18-1
Enabling or Disabling VRRP PiNgG ....coiuiiiiiiiii e 18-1
Chapter 19
Configuring X.25 Services
VEISION 15.4.0.0 ooiiiiiiiiiii et 19-1
Enabling the QLLC XID Retry Feature ... 19-1
Setting the LLC CONNECE TIMET ....ueiiiiiiiiiieeeiee et 19-2
Accepting Incoming X.25 Calls for QLLC ServiCe .........coveeiiiiiiiieiiiiiiiee e 19-2
K25 PAD ..ttt b et e e ab e e s 19-2
Chapter 20
Quick-Starting Routers
BT 7T T T T 0 X 0 SRR 20-1
SPARCstation System ReqUIremMents ..........ccceviiiiiiiiiiiiieie e 20-1
HP 9000 Workstation System Requirements ..........cccceviiiiiiiiiiiiiiiee e 20-2
Chapter 21
Reference for BCC IP show Commands
VErSION 15.5.0.0 oottt e ettt e e e e e e e e e e e e nr et e e eaaaa e e e e annn 21-1
Modified Output for the GRE Keepalive Mechanism .........cccccceveeeiiiiiiiiiiieeeeeeeeeen 21-1
Show gre 10gical-ip-tUNNEIS .........ooiiiii e 21-2
show gre 10gical-ipX-tUNNEIS .........c.uuiiiiiiiii e 21-3
Show gre physSiCal-tuNNEIS ...........ooiiiiii e 21-4

Xii 314470-15.7 Rev 00



Chapter 22
Upgrading Routers to BayRS Version 15.x

BT 7T o T T2 0 X O SRR 22-1
Why You Upgrade Boot and Diagnostic PROMS ..........ccccoiiiiiiiiiiiieniee e 22-1
VEISION 15.3.0.0 1oiiiiiiiiiiiei et e et e e e e e e e e et e e e e e e e e e e e e an e nnnaeerreeeeeeeeeanannns 22-3
Site Manager Upgrade PrerequISItes ..........ooocueiiiiiieiiiie i 22-3
Reviewing Site Manager System Requirements ..........ccccccoviiiieeiiniiiee i, 22-3
VErSION 15.4.0.0 .oeiiiiiiiiiii et 22-4
Upgrading and Verifying PROMS .......cooiiiiiieee e 22-4
Task 2: Updating the Existing Configuration File ..........ccccoiiiiiiii e, 22-8
Booting the Existing Configuration File ...........cccoiiiiiiiiie 22-8
Saving the Configuration File in Dynamic Mode ...........ccccoiiiiiiieienieceniee e 22-8
Chapter 23
Using Technician Interface Scripts
R 7T o T T T L0 X O SRR 23-1
Using Scripts and Aliases to Dynamically Configure a Router ...........cccooeeiiinens 23-1
Chapter 24
Using Technician Interface Software
R 7T o T T T L0 X O PSR 24-1
Diagnostics On/Off Option for ARN, Passport 2340, and Passport 5430 .............. 24-1
Setting Default Route Cost Using the Technician Interface ........ccccccceeeeiiiiiinninnnee. 24-1
VEISION 15.4.0.0 .ooiiiiiiiiiii et 24-2
Setting Daylight Savings Time Using the Technician Interface ...........ccccccviveeeen... 24-2
Removing the Technician Interface Login Banner ........cccoccveiiiiiiiiiiiiieie, 24-3
Chapter 25
Using the Bay Command Console (BCC)
VErSION 15.6.0.0 .ooeiiiiiiii e 25-1
Using the source Command to Configure a Router ..........cccoooviiiiiiiiiiiniieiciees 25-1
show hardware COMMANG .......c.eioiiiiiiiiie et 25-2
Configuring the BCC Inactivity TIMEr .......c.cooiiiiiiiiiiie e 25-4
Chapter 26
Event Messages for Routers
VEISION 15.7.0.0 oot 26-1
OSPF MD5 EVENES ..ottt e e e et e e e e snnre e e e e ennee e e e e nnnees 26-1

314470-15.7 Rev 00

Xiii



Warning BEVENTS ..o 26-1

INFO EVENES ..o e e e e e e e e e e e e e e aaaaas 26-4

3] =Y o1 £ S 26-6
FaUIt EVENES ..ot e e e e e e e e e e e e e e e e eereaeaaes 26-6
Warning BEVENTS ..o 26-7

INFO EVENIS ..o e e e e e e e e e e e e e e aeaaas 26-7

TraCE EVENIS e 26-28

TraCe EVENIS ..o 26-31

Appendix A
Site Manager Parameters

Adjacent HOSt ParameEter .........uueeiiiiiei e e e e e e e e e e e e e e e ee e A-3
ATM LiNE Parameters .......uuuuiuiiiiiiiiii e e e e ettt s e e e e e e e e e e aaaaaaeeeeeeneaees A-3
F I o g G =T =0 0 [= (= PP A-7
ATM Service Record Parameter ...........cccuuiiiiiiiiee e A-10
Automated Security Association (IKE) Parameters .........ccccccveeeeeeieeiccciiieieeeeeee e A-11
BGP-3-Specific Announce Policy Parameter ... A-12
BGP-4-Specific Announce Policy Parameter .........ccccveeeiieicciciiiiieeeeee e A-13
CSMA/CD PArameter ......oeeeiiiieiiiieeteeeeee ettt e e et e e e e e e e e e e e eeannees A-14
DSQMS RED Parameters ......ccccuuiiiiiiieeeeieieiiiiiiieeee e e e e e e e e e s aeaee e e s e e e e e e s s s ennnnneeeeees A-15
DSQMS Interface Parameters ... A-17
DSQMS QUEUE Parameters ........uuuiiiiiiiiieeiiiiciiie e e e e e e e s arr e e e e e e e e s s snnenreeeeees A-20
DSQMS Queue Classifier Parameters ..........ccccueeeeeeieiieeiieiiiiiieeeee e A-26
Frame Relay PVC Parameters ........ccuiieeiiiiiiiiiiiieiieeee et ee e e e e e e e e e s eee s A-28
Frame Relay Service Record Parameter ... A-32
Frame Relay SVC Parameters ........ccuiieiiiiiiiiiiiieiieeee et e e e e e e e ee s A-33
GRE Remote Connection Parameters ............oooiiiiiiiiiiiiiieii e A-34
IGMP GIObal Parameters ..........uuuuiiiiiiieeeie it tee e e e e e e s s e e e e e e e e e e s s nnnanneeeeeees A-36
IGMP Interface Parameters ... A-40
IGMP Translation Table Parameters ..........ccocciiiiiiiiiie e A-46
IGMP Static Forwarding Policy Parameters ..o A-47
[P GIObal Parameters ........ccccuuviiiiiiiieie e ettt e e e e e e s e e e e e e e e e e s s nnnanreeeeees A-48
IP Interface ParameEter ........ oo a e A-51
N DY I C o) o =TI =Y =0 1 1= (=Y S A-51
OSPF GIObal PArameter ........cocoiiiiiiiieeeeee et e e A-52

OSPF Area ParametersS .......ccuuiiiiiiieiieie et e e e e e e e e e s e et e e e e s eeaa e e e e e e eaananss A-53



OSPF Interface Parameters ......ooocoeuueiiiiieeeeee ettt e e e e e e e eaaaanas A-56

OSPF Virtual Interface Parameters ...........ooooeeiiiiiiiiiiiiiiieeeee et A-58
OSPF/RIP Announce Policy Parameter ...........cooiicciiiiiiiiiieee e csciveeeeee e e e e e e A-60
PIM Global Parameters .............uuuieiiiiieiiii ittt A-61
PIM Interface Parameters ..........uuuiiiiiiieeiii e ee e r e e e e e e e e e s eaaeeeeee s A-65
PIM Static RP Parameters ...........eoeiiiiiiiiiiieeieeee et A-66
PPP Interface Parameters ...........uueeiiiiiiiiiiieicieeee e e e e A-67
PPP Multilink Multiclass Classes Parameter ........ccccccoooeeiiiiiiiiiiiiieeeee e A-68
[ el IR o = =0 =) (= S A-69
QLLC Mapping Table Configuration Parameter .........ccocceiieiiiiiiiii e A-69
RADIUS Access Control Parameters ........ccccvvvviiiiiieeei e cccieieeee e e A-70
RADIUS Client Parameters ..........cooiiiiiiiiiiiieciieeeeeee ettt A-71
|l = 1= 0 0= (= SN A-73
SSH GIObal PAramMEtEIS .....ccooiiiiiieeeeeeee et e e A-74
VAl = =T 1 =1 (= P A-77
X.25 Network Service Record Parameter .........cccccooooieiiiiiiieeiee e A-77
Index

314470-15.7 Rev 00

XV






Preface

BayRS* Version 15.7.0.0 is a software release that includes bug fixes and new
features added since BayRS Version 15.6.0.0. This document change notice
contains additions and amendments to the following BayRS publications since
Version 15.1.0.0:

*  BayRS Online Library

*  Configuring and Managing Routers with Site Manager
*  Configuring ATM Services

»  Configuring Bridging Services

»  Configuring Data Compression Services

»  Configuring Differentiated Services

*  Configuring DLSw Services

»  Configuring Ethernet, FDDI, and Token Ring Services
»  Configuring Frame Relay Services

*  Configuring GRE, NAT, RIPSO, and BFE Services

*  Configuring IP, ARP, RARP, RIP, and OSPF Services

*  Configuring IP Exterior Gateway Protocols (BGP and EGP)
*  Configuring IP Multicasting and Multimedia Services
*  Configuring IP Utilities

»  Configuring PPP Services

*  Configuring RADIUS

*  Configuring Traffic Filters and Protocol Prioritization
*  Configuring VRRP Services
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»  Configuring X.25 Services

*  Event Messages for Routers

*  Quick-Starting Routers

*  Reference for BCC IP show Commands

*  Upgrading Routers to BayRS Version 15.x
*  Using Technician Interface Scripts

»  Using Technician Interface Software

*  Using the Bay Command Console (BCC)

Before You Begin

Before using this guide, you must complete the following procedures. For a new
router:

» Install the router (see the installation guide that came with your router).

*  Connect the router to the network and create a pilot configuration file (see
Quick-Starting Routers, Configuring Remote Access for AN and Passport
ARN Routers, or Connecting ASN Routers to a Network).

Make sure that you are running the latest version of Nortel Networks* BayRS and
Site Manager software. For information about upgrading BayRS and Site
Manager, see the upgrading guide for your version of BayRS.
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Text Conventions

This guide uses the following text conventions:

angle brackets (<>)

bold text

braces ({})

brackets ([ ])

italic text

Indicate that you choose the text to enter based on the
description inside the brackets. Do not type the
brackets when entering the command.

Example: If the command syntax is:
ping <ip_address>, you enter ping 192.32.10.12.

Indicates command names and options and text that
you need to enter.

Example: Enter show ip {alerts | routes}.

Example: Use the dinfo command.

Indicate required elements in syntax descriptions
where there is more than one option. You must choose
only one of the options. Do not type the braces when
entering the command.

Example: If the command syntax is:
show ip {alerts | routes}, you must enter either:
show ip alerts or show ip routes, but not both.

Indicate optional elements in syntax descriptions. Do
not type the brackets when entering the command.

Example: If the command syntax is:
show ip interfaces [-alerts], you can enter either:
show ip interfaces or show ip interfaces -alerts.

Indicates new terms, book titles, and variables in
command syntax descriptions. Where a variable is two
or more words, the words are connected by an
underscore.

Example: If the command syntax is:
show at <valid_route>, valid_route is one variable and
you substitute one value for it.

314470-15.7 Rev 00

XiX



BayRS Version 15.7.0.0 Document Change Notice

separator (>)

vertical line ( | )

Acronyms

Shows menu paths.

Example: Protocols > IP identifies the IP option on the
Protocols menu.

Separates choices for command keywords and
arguments. Enter only one of the choices. Do not type
the vertical line when entering the command.

Example: If the command syntax is:
show ip {alerts | routes}, you enter either:
show ip alerts or show ip routes, but not both.

This guide uses the following acronyms:

ARP
AS

ASE
ATM
BGP
DLSw
DSCP
DSQMS

ECMP
FDDI
GRE
HSSI
ICMP
IGMP
1P
[Psec

Address Resolution Protocol
autonomous system

autonomous system external
asynchronous transfer mode
Border Gateway Protocol

data link switching

differentiated services code point

differentiated services queue management and
scheduling

equal-cost multipath

Fiber Distributed Data Interface
Generic Routing Encapsulation

High Speed Serial Interface

Internet Control Message Protocol
Internet Group Management Protocol
Internet Protocol

Internet Protocol Security

XX
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LCP
LLC
LMI
LQM
LQR
LSA
LSDB
MD5
MIB
MTU
NAT
NLPID
NSSA
OSPF
PBBI
PBBR
PIM
PMC
PPP
PVC
QLLC
QoS
RADIUS
RARP
RED
RIP
RP
SM
SNMP

Link Control Protocol

logical link control

Local Management Interface
Link Quality Monitoring

Link Quality Report

link state advertisement

link state database

Message Digest 5 authentication
management information base
maximum transmission unit
Network Address Translation
network layer protocol identifier
not-so-stubby area

Open Shortest Path First

PIM bootstrap border interface
PIM bootstrap border router
Protocol Independent Multicast
PCI mezzanine card
Point-to-Point Protocol
permanent virtual circuit
Qualified Logical Link Control

quality of service

Remote Access Dial-In User Services

Reverse Address Resolution Protocol

random early detection
Routing Information Protocol
rendezvous point

sparse mode

Simple Network Management Protocol
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SSM source-specific multicast

SRB source route bridge

SVC switched virtual circuit

ToS type of service

VC virtual circuit

VRRP Virtual Router Redundancy Protocol

Hard-Copy Technical Manuals

You can print selected technical manuals and release notes free, directly from the
Internet. Go to the www.nortel.com/support URL. Find the product for which you
need documentation. Then locate the specific category and model or version for
your hardware or software product. Use Adobe* Acrobat Reader* to open the
manuals and release notes, search for the sections you need, and print them on
most standard printers. Go to Adobe Systems at the www.adobe.com URL to
download a free copy of the Adobe Acrobat Reader.

How to get help

This section explains how to get help for Nortel products and services.

Getting help from the Nortel web site

The best way to get technical support for Nortel products is from the Nortel
Technical Support web site:

www.nortel.com/support
This site provides quick access to software, documentation, bulletins, and tools to
address issues with Nortel products. From this site, you can:

» download software, documentation, and product bulletins

» search the Technical Support web site and the Nortel Knowledge Base for
answers to technical issues

» sign up for automatic notification of new software and documentation for
Nortel equipment

XXii

314470-15.7 Rev 00


http://support.avaya.com
http://www.adobe.com
http://support.avaya.com

Preface

» open and manage technical support cases

Getting help over the phone from a Nortel Solutions Center

If you do not find the information you require on the Nortel Technical Support
web site, and you have a Nortel support contract, you can also get help over the
phone from a Nortel Solutions Center.

In North America, call 1-800-4NORTEL (1-800-466-7835).

Outside North America, go to the following web site to obtain the phone number
for your region:

www.nortel.com/callus

Getting help from a specialist by using an Express Routing Code
To access some Nortel Technical Solutions Centers, you can use an Express
Routing Code (ERC) to quickly route your call to a specialist in your Nortel

product or service. To locate the ERC for your product or service, go to:

www.nortel.com/erc

Getting help through a Nortel distributor or reseller

If you purchased a service contract for your Nortel product from a distributor or
authorized reseller, contact the technical support staff for that distributor or
reseller.
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Chapter 1
BayRS Online Library CD

The BayRS Online Library documentation CD (Part No. 314472-A) was last
updated for BayRS Version 15.2.0.0. This document change notice contains
amendments to the BayRS software manuals since BayRS Version 15.1.0.0.
Any hardware guide that has been revised since the final documentation CD was
released is posted on the Nortel Networks Technical Support site.

Accessing Nortel Networks Documentation on the Web

To access the latest version of BayRS hardware and software documents on the
Nortel Networks Technical Support Web page:

1. Go to the Technical Support URL www.nortel.com/support.
Click on the “Browse product support” tab.

From the Product Families list, choose “BayRS Routers.”

bl

From the Product list, choose the hardware platform for which you need
documentation (for example, Multiprotocol Router 5430).

=p | Note: The Passport 5430 and the Passport 2430 are now referred to as the
Multiprotocol Router 5430 and the Multiprotocol Router 2430.

5. From the Content list, choose “Documentation” and then click on Go.

On the resulting documentation page, you can use keywords or menu options to
search for specific documents. You can view, print, and download any document
from the Web site.
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Chapter 2
Configuring and Managing
Routers with Site Manager

Version 15.3.0.0

The following section is an amendment to Chapter 7, “Monitoring Trap and Event
Messages,” in Configuring and Managing Routers with Site Manager.

Changing the Trap Port for Multiple Network Management

Applications

If you are running more than one network management application on your Site
Manager workstation, you must configure Site Manager to receive trap messages
from the SNMP agent on a port other than the default port, 162. This is necessary
for the following reasons:

The agent can only send trap messages to one network management
application at a time.

Only one application can map to a UDP port at a time.

By default, the network management application on your workstation is
assigned to User Datagram Protocol (UDP) port 162. This port is dedicated to
receiving SNMP trap messages from the SNMP agent.

Site Manager is the preferred network management application for receiving
trap messages. To avoid any problems when running another network
management application, Nortel Networks recommends that you configure
Site Manager to map to an alternative UDP port. This allows you to send trap
messages to Site Manager directly.

314470-15.7 Rev 00
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To reconfigure the trap port:

1. In the Configuration Manager window, choose Protocols > IP > SNMP >
Communities.

The SNMP Community List window opens.
2. Choose Community > Managers.
The SNMP Manager List window opens.
3. Choose Manager > Edit Manager.
The Trap Port and Trap Types window opens.
4. Type a new port number for the Trap Port parameter, then click on OK.

You can enter any port number on your Site Manager workstation, as long as
another application is not using that port.

You return to the Configuration Manager window.
5. Choose File > Save to save this configuration file.

See Chapter 3 in Configuring and Managing Routers Using Site Manager for
instructions on saving configuration files.

6. Choose File > Exit.
You return to the main Site Manager window.

7. Restart Site Manager according to the instructions in Chapter 1 of
Configuring and Managing Routers Using Site Manager.

To make sure that Site Manager is able to listen to the port that you
configured in step 4, restart Site Manager using the wfsm -e command or the
Trap Monitor using the wftraps -e command. For more information, about
using the wfsm and wftraps commands with the -e option, see Appendix A in
Configuring and Managing Routers with Site Manager.

Note: You can also change the trap port on a PC by editing the

=»| snmp-trap 162/udp snmp string in the Services file. From the Start menu,
choose Programs > Windows Explorer. Open the Services file and edit the
string snmp-trap 162/udp snmp. For example, to change the trap port from 162
to 779, enter snmp-trap 779/udp snmp and reboot the PC. Site Manager PC
is then able to receive the traps from the router on port 779.
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Chapter 3
Configuring ATM Services

Version 15.2.0.0

The following section is new to Configuring ATM Services. You use the
procedures in this section to configure an ATM T3/E3 PMC module installed in a
Passport* 5430. For information about installing an ATM T3/E3 PMC module,
see ATM T3/E3 PMC Module Supplement.

Creating an ATM Circuit for a T3 or E3 Connection on a Passport 5430
To start ATM services on an ATM T3/E3 PMC module in the Passport 5430, you
do the following:

1. Configure the physical ATM circuit.

2. Add protocols and other services to that circuit.

This section describes how you create a physical ATM circuit for a T3 or E3
connection on a Passport 5430, then directs you to Configuring ATM Services for
information about adding protocols and further configuring ATM services.

Using the BCC

To add ATM to a Passport 5430 with a T3/E3 connector, navigate to the box
prompt and enter:

atm slot <slot_number> pci-slot <pci_slot> module <module_number>
connector <connector_number> mode {t3 | e3}

slot_number is the number of the chassis slot containing the ATM T3/E3 PMC
module.
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pci_slot is the number of the PCI slot containing the ATM T3/E3 PMC module.
The PCI slot number for the ATM T3/E3 PMC module is always 1.

module_number is always 2 for the ATM interface.
connector_number is the number of a connector on the ATM T3/E3 PMC module.
mode t3 or mode e3 specifies whether the ATM interface is a T3 or E3 interface.

For example, the following command adds an ATM T3 interface to the Passport
5430 configuration on slot 1, PCI slot 1, module 2, connector 1:

box# atm slot 1 pci-slot 1 module 2 connector 1 mode t3
atm/1/1/2/1#

To configure T3/E3 parameters, use the following procedures.

Specifying the Cable Length

To specify the cable length, navigate to the ATM interface prompt (for example,
box; atm/1/1/2/1; atm-e3) and enter:

cable-length </ength>

length is either short (default) or long. Specify short for a cable less than 225 feet
long; specify long for a cable length of 225 feet or more.

For example, the following command changes the cable length to long:

atm-e3/1/1/2/1# cable-length long
atm-e3/1/1/2/1#

Specifying the Clear Alarm Threshold

To specify the duration of time (in seconds) that elapses following the clearing of
a performance failure (before the condition is registered and logged), navigate to
the ATM interface prompt (for example, box; atm/1/1/2/1; atm-e3) and enter:

clear-alarm-threshold <integer>

integer is a value from 2 through 10 seconds, inclusive.

3-2
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For example, the following command changes the clear alarm threshold from 2 to
8 seconds:

atm-e3/1/1/2/1# clear-alarm-threshold 8
atm-e3/1/1/2/1#

Specifying the Line Coding Method

To specify the line coding method, navigate to the ATM interface prompt (for
example, box; atm/1/1/2/1; atm-e3) and enter:

line-coding {hdb3 | b3zs}

The default for the ATM E3 interface is hdb3 and the default value for the ATM
T3 interface is b3zs.

Specifying the Line Type

To specify the line type for this interface, navigate to the ATM interface prompt
(for example, box; atm/1/1/2/1; atm-e3) and enter:

line-type <type>

type is autodetect, ds3m?23, or ds3cbitparity for the ATM T3 interface and
e3framed or e3plcp for the ATM E3 interface.

If the line type is ds3m23, the framing mode should be m23 or t3m23plcp.
If the line type is ds3cbitparity, the framing mode should be cbit or t3cbitplcp.

If the line type is either e3framed or e3plcp, the framing mode should be either
g751or g832.

For instructions on setting the framing-mode parameter, see Configuring ATM
Services.

Specifying the Loopback Mode

To force the interface into loopback mode so that the far-end or intermediate
equipment can perform diagnostics on the network between that equipment and
the T3/E3 interface, navigate to the ATM interface prompt (for example, box;
atm/1/1/2/1; atm-e3) and enter:

loopback-mode <type>
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type is payloadloop or lineloop.

If you select payloadloop, the received signal at this interface is looped through
the device. Typically, the received signal is looped back for retransmission after it
has passed through the device’s framing function.

If you select lineloop, the received signal at this interface does not go through the
framing device (minimum penetration) but is looped back out. The default is
noloop.

For example, the following command changes the loopback mode to payloadloop:
atm-e3/1/1/2/14 loopback-mode payloadloop

atm-e3/1/1/2/1#%

Defining the Interface MTU

The maximum transmission unit (MTU) is the largest possible unit of data that the
physical medium can transmit. By default, the interface allows an MTU size of
4608 octets. This value can handle most packet sizes. However, you can set the
MTU to any value from 3 through 4608 octets.

To modify the interface MTU, navigate to the ATM interface prompt (for
example,
box; atm/1/1/2/1; atm-e3) and enter:

mtu <integer>
integer is the MTU size in octets.

For example, the following command sets the MTU size to 3000 octets:

atm-e3/1/1/2/1# mtu 3000
atm-e3/1/1/2/1#

Defining the Primary Clock Source

To define the clock signal source, navigate to the ATM interface prompt (for
example, box; atm/1/1/2/1; atm-e3) and enter:

primary-clock-source <value>

value is internal or loop. If you select internal, the router will generate the clock
signal source. If you select the default, loop, the clock signal source will be
external to the router.

3-4
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For example, the following command sets the clock source to internal:
atm-e3/1/1/2/14 primary-clock-source internal
atm-e3/1/1/2/1#%

Specifying the Setup Alarm Threshold

To specify the duration of time (in seconds) that elapses following the detection of
a performance failure, before the condition is registered and logged, navigate to
the ATM interface prompt (for example, box; atm/1/1/2/1; atm-e3) and enter:

setup-alarm-threshold <integer>

integer is a value from 2 through 10 seconds, inclusive.

For example, the following command changes the setup alarm threshold from 2 to
8 seconds:

atm-e3/1/1/2/1# setup-alarm-threshold 8

atm-e3/1/1/2/1#

Disabling and Reenabling the ATM interface

By default, the ATM interface is enabled when you create the circuit. However,
you can disable or reenable the interface at any time. When the interface is
enabled, traffic can flow over the interface. When the interface is disabled, traffic
cannot flow over the interface.

To disable or reenable the ATM interface, navigate to the ATM interface prompt
(for example, box; atm/1/1/2/1; atm-e3) and enter:

state {disabled | enabled}

For example, the following commands disable and reenable the ATM interface:

atm-e3/1/1/2/1# state disabled
atm-e3/1/1/2/1# state enabled
atm-e3/1/1/2/1#
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Using Site Manager

To create an ATM circuit for a T3 or E3 connection on a Passport 5430, complete
the following tasks:

Site Manager Procedure

You do this

System responds

1.

In the Configuration Manager window,
click on the ATM DS3/ES interface (ATM1)
in slot 1, PCl slot 1, module 2.

The Add Circuit window opens.

2. Click on OK to accept the default circuit The ATM Configuration window opens.
name.
3. Click on Physical Layer Configuration. | The Physical Layer Configuration window
opens.
4. Click on either DS3 or E3. The Port Parameters window opens.

5. To configure port parameters, set the

following parameters as needed:

e Enable/Disable

Line Type

Setup Alarm Threshold (seconds)
Clear Alarm Threshold (seconds)
Loopback Configuration

Primary Clock

Click on Help or see the parameter
descriptions in “ATM Line Parameters,”
beginning on page A-3.

Click on OK.

The Physical Layer Configuration window
opens.

7. Click on Done.

The ATM Configuration window opens.

8. Click on ATM Line Attributes.

The ATM Line Driver Attributes window
opens.

(continued)
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Site Manager Procedure (continued)

You do this

System responds

9.

Set the the following parameters as
needed:

Enable

Interface MTU

Data Path Enable

Data Path Notify Timeout
Framing Mode

Cell Scrambling

Per-VC Clipping

DS3 Line Build Out

Note: The Cell Scrambling parameter
value must be the same as for the other
ATM devices on your network. See your
system administrator or your service
provider for the appropriate value.

Click on Help or see the parameter
descriptions in “ATM Line Parameters” on
page A-3.

in Configuring ATM Services.

10. Click on OK. The ATM Configuration window opens.
11. Click on ATM. The Edit ATM Connector window opens.
12. Go to “Defining an ATM Service Record”

After you create the ATM circuit, go to Chapter 2, “Starting ATM and ATM
Router Redundancy,” in Configuring ATM Services to finish configuring ATM
services.

Configuring ATM Services also provides more information about ATM services
and how to modify an existing ATM configuration.
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Version 15.3.0.0

The following sections contain amendments to Chapter 3, “Customizing an ATM
Interface,” in Configuring ATM Services.

Defining the SVC Inactivity Timeout

When you enable the SVC inactivity timeout function (the default), the router
automatically terminates any SVCs that have not received or transmitted any
cells. If you disable the SVC inactivity timeout function, all SVCs on the line
remain open until you close them by another method.

When enabled, the SVC inactivity timeout function also requires a timer value.
This timer value specifies how long you want the ATM router to wait before
disabling inactive SVCs. By default, if the router does not receive or transmit any
cells for 1200 seconds, the inactive SVCs are disabled. However, you can set this
timer to any value from 60 to 3600 seconds.

Using the BCC

To disable the SVC inactivity timeout function, navigate to the ATM prompt (for
example, box; atm/11/1) and enter:

vc-inactivity-control disabled

For example, the following command disables the SVC inactivity timeout
function on the ATM interface:

atm/11/1# ve-inactivity-control disabled
atm/11/1#

To reenable the SVC inactivity timeout function, navigate to the ATM prompt and
enter:

ve-inactivity-control enabled

Note: The vc-inactivity-control parameter is not available for use with the
ATM T3/E3 PMC module. Instead, the ve-inact-control parameter appears
for this module. The vec-inact-control parameter cannot be modified.

3-8
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To change the SVC inactivity timeout value, navigate to the ATM prompt and
enter:

vc-inactivity-timeout <integer>

integer is the amount of time (in seconds) that the router waits before it disables
inactive SVCs.

For example, the following command sequence reenables the SVC inactivity
timeout function on the ATM interface and sets the SVC inactivity timeout value
to 2400 seconds:

atm/11/1# ve-inactivity-control enabled
atm/11/1# ve-inactivity-timeout 2400
atm/11/1#

Note: The vc-inactivity-timeout parameter is not available for use with the
ATM T3/E3 PMC module. Instead, the ve-inact-timeout parameter appears
for this module. The ve-inact-timeout parameter cannot be modified.
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Defining the Clocking Signal Source

You can specify either an internal or external clocking source for time signals.
Internal clocking uses the router clock; external clocking uses the line clock.

Using the BCC

To change the source of the ATM clocking signal, navigate to the ATM prompt
(for example, box; atm/11/1) and enter:

clock-signal-source <source>
source is either internal (default) or external.

For example, the following command changes the ATM clocking signal source to
external:

atm/11/1# clock-signal-source external

atm/11/1#

Note: The clock-signal-source parameter is not available for use with the
ATM T3/E3 PMC module. Instead, the clk-signal-source parameter appears
for this module. The clk-signal-source parameter cannot be modified.

3-10
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Version 15.5.0.0

The following sections contain amendments to Chapter 3, “Customizing an ATM
Interface,” in Configuring ATM Services.

Turning DS-3 and E3 Cell Scrambling On and Off

Beginning with BayRS Version 15.5.0.0, the BCC parameter used to turn ATM
cell scrambling on and off for DS-3 and E3 interfaces has a new, more specific
name. To eliminate confusion, the scrambling parameter is now named
ds3e3-scrambling.

The default value (off) for the ds3e3-scrambling parameter (ATM cell
scrambling feature) remains the same.

The procedure for using Site Manager to configure ATM cell scrambling on DS-3
and E3 interfaces has not changed.

Note: ATM cell scrambling is supported only for DS-3 and E3 interfaces.
nd Attempts to configure the ds3e3-scrambling parameter on other interfaces
(for example, OC-3 interfaces), generates the following error message:
Scrambling can be modified only for DS3/E3 Interface.
Using the BCC

To turn on cell scrambling for a DS-3 or E3 interface, navigate to the ATM
prompt (for example, box; atm/11/1) and enter:

ds3e3-scrambling on

For example, the following command turns on cell scrambling for ATM
connector 1 in slot 11:

atm/11/1#% ds3e3-scrambling on
atm/11/1#

To turn cell scrambling off, navigate to the ATM prompt and enter:

ds3e3-scrambling off
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For example, the following command turns cell scrambling off for ATM
connector 1 in slot 11:

atm/11/1#% ds3e3-scrambling off
atm/11/1#

Version 15.6.0.0

The following section contains amendments to Chapter 5, “Customizing PVC
Service Records and PVCs,” and Chapter 7, “Customizing Classical IP Service
Records,” in Configuring ATM Services (part number 308612-15.1 Rev 00).

Virtual Circuit Monitoring with the ifSpeed MIB Attribute

A number of network management and performance management applications
use the ifSpeed MIB attribute to calculate traffic utilization on virtual circuits and
to generate alarms when traffic utilization exceeds certain thresholds. Before
Version 15.6, BayRS automatically set the ifSpeed MIB attribute to the line speed
of the interface, not to the speed of the ATM virtual circuits on that interface.

BayRS Version 15.6 supports a new parameter—called Optional Line Speed—for
ATM service records; the value that you set for this parameter is reported by the
ifSpeed MIB variable. In this way, network management applications can use
SNMP to obtain a user-configured value for the ifSpeed variable for a virtual
circuit and generate alarms as appropriate.

Note: This new parameter applies to the service record only regardless of how
many virtual circuits are configured under that service record.

By default, the ifSpeed variable is set to the line speed of the interface. You can
set the optional line speed parameter to a value corresponding to the rate of the
virtual circuit; that value will be reflected in the corresponding ifSpeed entry for
each VC on the service record.

Note: The value that you set is for reporting purposes only; it has no effect on
the actual performance of the ATM virtual circuit.

3-12
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You can use the BCC or Site Manager to configure the optional line speed
parameter on a service record.

Using the BCC

You can specify a line speed value for a PVC service record or for a classical IP
service record.

To set the line speed value, navigate to the service record prompt (for example,
box; atm/11/1; pvc-service/boston or box; atm/11/1; classical-ip-service/
dallas) and enter:

optional-line-speed <infeger>
integer is the line speed for the service record in bits per second.

For example, the following command sets the line speed for classical IP service
record “dallas” to 1000000 bits per second:

classical-ip-service/dallas# optional-line-speed 1000000
classical-ip-service/dallas#

Using Site Manager

To specify a line speed value for a PVC service record or for a classical IP service
record, complete the following tasks:

Site Manager Procedure

You do this System responds
1. In the Configuration Manager window, The Select Connection Type window
click on the ATM interface (ATM1) that opens (BN), or the ATM Configuration
you want to modify. window opens (Passport 5430).
2. Click on ATM. The Edit ATM Connector window opens.
3. Click on Service Attributes. The ATM Service Records List window
opens.

4. Click on the PVC or classical IP service
record that you want to configure a line
speed for.

5. Set the Optional Line Speed parameter.
Click on Help or see the parameter
description on page A-10.

(continued)
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Site Manager Procedure (continued)

You do this

System responds

6. Click on Done.

You return to the Edit ATM Connector
window.

7. Click on Done.

You return to the ATM Configuration or
the Select Connection Type window.

8. Click on Done.

You return to the Configuration Manager
window.
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Configuring Bridging Services

Version 15.2.0.0

The following section corrects an error in Configuring Bridging Services.

Interfaces Supported

The section “Interfaces Supported” under “Implementation Notes™ in Configuring
Bridging Services incorrectly states that the translation bridge can operate on all
source routing (SR) interfaces supported by Nortel Networks routers except IP.
The translation bridge can operate on all SR interfaces supported by Nortel
Networks routers except for interfaces configured for SRB with IP encapsulation.

Version 15.5.0.0

The following section corrects an omission in the “Customizing Global Source
Routing Bridge Parameters” section of Chapter 7, “Configuring Source Routing
Bridge Services Using the BCC,” in Configuring Bridging Services.
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Specifying the IP Network Ring ID for the Source Routing Bridge

You can use the BCC to specify a ring ID for the backbone IP network to which
the source routing bridge connects. You must specify the same IP network ring ID
for each Nortel Network’s source routing bridge that connects to the network.

To specify the ring ID for the backbone IP network to which the source routing
bridge connects, navigate to the global srb prompt (for example, box; srb) and
enter:

ip-net-ring-id <id_number>

id_number is a hex value from 0x0 to Oxffe. The default value is 0x0. Assign the
same value to all Nortel Network’s source routing bridges that border the IP
network cloud. The IP network ring ID must be unique among any other group
LAN IDs, ring IDs, or internal LAN IDs in the network.

For example, the following command assigns the [P network ring ID value 0x1 to
the source routing bridge:

srb# ip-net-ring-id 0x1

4-2
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Configuring Data Compression Services

Version 15.5.0.0

The following notice supplements Chapter 1, “Starting Compression Services,” in
Configuring Data Compression Services.

Hi/fn LZS Compression for Passport 2430 and Passport 5430

Beginning with Version 15.5.0.0, BayRS adds Hi/fn LZS (Lempel Ziv STAC)
compression capability to the Passport 2430 and Passport 5430, thus extending
optional Hi/fn* LZS* compression capability to all BayRS router platforms.

The use of Hi/fn compression improves the bandwidth utilization of a wide area
network (WAN) link by removing redundancies in data traffic, which increases
the effective throughput of the link. Hi/fn compression is standards based and
permits interoperability with third party routers.

For information about configuring Hi/fn LZS compression, see Configuring Data
Compression Services.
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Version 15.6.0.0

The following information supplements Chapter 1, “Starting Compression
Services,” in Configuring Data Compression Services.

IP Payload Compression over GRE Tunnels

Before Version 15.6, BayRS implemented software-based data compression that
compresses the entire IP packet for transmission over PPP, frame relay, and X.25
networks. As service providers increasingly adopt IP/MPLS topologies, the IP
header of the packet must be left uncompressed to route packets around the
IP/MPLS core. IP payload compression provides a means for compressing only
the data that follows the IP header.

IP payload compression provides Layer 3 compression end-to-end over low-speed
Ethernet and WAN interfaces. IP payload compression is transparent to the
underlying Layer 2 protocols and therefore increases compression interoperability
with other IP devices in the network.

The BayRS implementation of IP payload compression operates between two
BayRS routers and uses the STAC LZS compression algorithm.

Note: The Hi/fn LZS compression software is licensed from Hi/fn, Inc. You
must separately purchase a license for the Hi/fn LZS compression software,
which is delivered on a separate CD by Nortel Networks.

You configure IP payload compression on the logical IP address associated with a
GRE tunnel end point. Compression (or decompression) is applied to the packets
before they exit the GRE tunnel end point.

IP payload compression is supported on all BayRS routers on the following
low-speed interfaces: 10BASE-T Ethernet, serial, T1/FT1, E1/FE1, ISDN BRI,
and 56/64K CSU/DSU.

Note: You can configure IP payload compression on only one 10BASE-T
Ethernet interface per slot.

IP payload compression is not supported on 100BASE or 1000BASE Ethernet
interfaces, HSSI interfaces, or ATM DS3/OC3 interfaces.

5-2
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How IP Payload Compression Is Accomplished

IP payload compression is performed on packets that are originated by the router
and on packets that pass through the router. (Packets that are smaller than 90 bytes
are not compressed.) The process of IP payload compression is briefly
summarized here:

1. In the IP header, the original IP protocol type is replaced with the value for
IPCOMP (108).

2. Following the original IP header, an IP compression header is added that
contains the IP protocol field from the original IP header, a flags field, and the
compression protocol index (that is, STAC LZS).

3. The length of the IP header and its checksum are updated to reflect the
compressed data and the addition of the new IP compression header.

Note: If the total size of the compressed payload and the IP compression
header is not smaller than the size of the original payload, the IP packet is sent
in its original uncompressed form, with no IP compression header added to it.

For more information about IP payload compression, refer to the following
documents:

*  Shacham, A., B. Monsour, R. Pereria, and M. Thomas. /P Payload
Compression Protocol (IPComp). RFC 3173. Network Working Group.
September 2001.

* Friend, R., and R. Monsour. /P Payload Compression Using LZS. RFC 2395.
Network Working Group. December 1998.

Implementation Notes

Before you configure IP payload compression, note the following considerations:

*  To support IP payload compression, Hi/fn LZS compression is now available
for the FRE-4-PPC module. If you plan to use IP payload compression on a
BN router with a FRE-4-PPC module, see “Hi/fn LZS Compression for BN
Routers with FRE-4-PPC Modules” on page 5-7.

e The BayRS implementation of IP payload compression operates only between
two BayRS routers over a GRE tunnel.

*  You cannot configure both IP payload compression (Layer 3) and PPP or
frame relay compression (Layer 2) on the same interface.
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* IP payload compression is not supported with [Psec/IKE.

*  Small packets may not compress well. (Packets smaller than 90 bytes are sent
uncompressed.)

» Ifpacket fragmentation is also configured, compression of outbound IP
packets is performed before packet fragmentation.

*  Certain packet filters that are based on Layer 4 information may not work
with IP payload compression.

To implement IP payload compression, you must do the following:
1. Configure a GRE tunnel between two Nortel Networks routers.
2. Add alogical IP interface to the local and remote tunnel end points.

3. [Enable IP payload compression on each logical IP interface.

Local logical Remote logical
host interface host interface

/ Compression/ Compression/ \

Decompression Decompression
— MPLS \ ——

EC__ L] = L]

Y — |
Ro;Jter INDAN @/ Ro;ter
Local physical Remote physical
router interface router interface
TIPO095A
Figure 5-1. Implementation of IP Payload Compression
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Configuring IP Payload Compression

You can use the BCC or Site Manager to configure IP payload compression on an
IP interface that is configured on a GRE tunnel. By default, IP payload
compression is disabled.

Using the BCC

To enable or disable IP payload compression and decompression, go to the IP
interface prompt configured on the GRE tunnel (for example, box; tunnels;
gre/chicago; ip/2.2.2.2/255.255.0.0) and enter:

payload-compression <state>

state is one of the following:

enabled
disabled (default)

For example, the following command sequences enables IP payload compression
and decompression on logical IP interface 2.2.2.2 configured on GRE tunnel
chicago:

box# tunnels

tunnels# gre/chicago

gre/chicago# ip/2.2.2.2/255.255.0.0

ip/2.2.2.2/255.255.0.04 payload-compression enabled
ip/2.2.2.2/255.255.0.0#%

The following command disables IP payload compression and decompression on
logical IP interface 2.2.2.2 configured on the GRE tunnel chicago:

ip/2.2.2.2/255.255.0.0# payload-compression disabled
ip/2.2.2.2/255.255.0.04#
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Using Site Manager

To enable or disable IP payload compression and decompression over a GRE
tunnel, complete the following tasks:

Site Manager Procedure

You do this

System responds

1.

In the Configuration Manager window,
choose Protocols.

The Protocols menu opens.

Choose IP.

The IP menu opens.

3. Choose Interfaces.

The IP Interface List window opens.

4. Select the IP interface configured on a

GRE tunnel that you want to edit for IP
payload compression.

Site Manager displays the parameter
values for that interface.

Set the IP Payload Compression
parameter. Click on Help or see the
parameter description on page A-51.

Click on Apply, and then click on Done.

You return to the Configuration Manager

window.

Displaying Statistics for IP Payload Compression

To display the list of GRE IP interfaces that are configured for IP payload
compression, enter the BCC command show hifn ipcomp.

bce> show hifn ipcomp

show hifn ipcomp

hifn ipcomp entries

Feb 17, 2005 15:35:54 [EST]

Circuit IP 1P

Name Address State
GRE1 1.1.1.1 notpres
GRE2 2.2.2.2 notpres
PPP_Demand 10.10.10.1 notpres
_2

E111 192.32.140.36 notpres

State

disabled

disabled
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To display statistics for the interfaces configured for IP payload compression,
including the number of bytes compressed and decompressed, enter the BCC
command show hifn ipcomp stats

box# show hifn ipcomp stats
show hifn ipcomp stats Feb 17, 2005 15:36:08 [EST]

hifn Performance And Data Statistics

Name Compress Decompress In Out Agg.In Agg.Out Tx Rx

GRE1 4.222 4.006 202772 48017 21140 84692 0 0
GRE2 -- 4.006 0 0 21140 84692 0 0

Hi/fn LZS Compression for BN Routers with FRE-4-PPC Modules

To support IP payload compression, BayRS Version 15.6.0.0 adds Hi/fn LZS
compression capability to the FRE-4-PPC module installed in a BN router. You
must separately purchase a license for the Hi/fn LZS compression software, which
is delivered on a separate CD by Nortel Networks.

This section supplements the CD insert that accompanies the Hi/fn LZS
Compression Option CD; it provides instructions for copying the new hifn.ppc
file from the Hi/fn CD to the BN router image.

Note: This information applies to BayRS Version 15.6 only. If you are
installing the Hi/fn software on a router other than a BN or on a BN that has no
FRE-4-PPC module, you do not need to read this section.

To install the Hi/fn LZS compression software on a BN router with a FRE-4-PPC
module:

1. From the Site Manager main window, choose Tools > Image Builder to start
the Image Builder.

=p | Note: For complete information about the Image Builder and the Router Files
Manager, see Configuring and Managing Routers with Site Manager.
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2.

10.

11.

12.

In the Image Builder window, choose File > Open and navigate to the copy of
the current BN router image (bn.exe) on your workstation.

Click on Details below the Current Components box.
Select the hifn.exe file under Baseline Router Software and click on Remove.

This hifn.exe file is only a placeholder. Note that the Component Information
box shows its compressed size as less than 2 KB.

Choose File > Save to save the modified image.
Exit the Image Builder.
Open the Image Builder directory for the BN router:

On a PC, the default directory is wf\builder.dir\rel<release number>\bn, for
example, wf\builder.dir\rel15600\bn.

On a UNIX" platform, the default directory is
~/.builder/rel<release _number>/bn, for example, ~/.builder/rel15600/bn.

Insert the Hi/fn LZS software CD into the CD-ROM drive.
Open the following folders on the CD in order: 15.6.0.0 (or greater), bn.
The bn directory contains the hifn.exe file and a directory called fre4.

If the BN router has FRE-2 or FRE-2-060 modules on which you want to run
Hi/fn LZS compression, copy the file 15xxx/bn/hifn.exe from the Hi/fn CD to
the BN platform directory under the Image Builder directory.

When you copy the hifn.exe file to an HP platform, it is automatically
renamed HIFN.EXE;1. You must rename the file to hifn.exe by executing the
following command:

mv “HIFN.EXE;1” hifn.exe
Note that you must use quotation marks before and after HIFN.EXE; 1.
Open the bn/fre4 directory on the Hi/fn CD.

To run IP payload compression on FRE-4-PPC modules, you must install the
hifn.ppc file that is in the bn/fre4 directory.

From the Hi/fn CD, copy the file 15xxx/bn/fre4/hifn.ppc to the BN platform
directory under the Image Builder directory.

5-8
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13.

14.

15.

16.
17.

When you copy the hifn.ppc file to an HP platform, it is automatically
renamed HIFN.PPC;1. You must rename the file to hifn.ppc by executing the
following command:

mv “HIFN.PPC;1” hifn.ppc
Note that you must use quotation marks before and after HIFN.PPC;1.

Start the Image Builder again and open the BN router image from which you
removed the hifn.exe file.

Click on Details under the Available Components box, select hifn.ppc (and
hifn.exe, if necessary), and click on Add.

Save the modified image that includes Hi/fn LZS compression to a new
directory and exit the Image Builder.

Use the Router Files Manager to transfer the new image to the BN router.

Perform a named boot with the new image, following the directions in
Configuring and Managing Routers with Site Manager.

You can now use Hi/fn LZS compression software on the BN router with a
FRE-4-PPC module.
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Chapter 6

Configuring Differentiated Services

Version 15.1.0.0

The following section describes a change to Configuring Differentiated Services.

Modifying RED Parameters

The following change is required to Table 6-1 in the “Modifying RED
Parameters” section of Configuring Differentiated Services.

The proper range of values for the id parameter is from 1 through 65535. The
proper range is shown in the following table, which lists RED parameters that can
be configured under dsqms-red, their values, and functions.

Parameter

Values

Function

id

integer 1 through
65535

Identifies the RED function. You cannot
change this parameter.

min-threshold

integer 0 through
100 (default 20)

Indicates the queue size below which no
packets are dropped by RED

max-threshold

integer 1 through
100 (default 80)

Indicates the queue size above which all
packets are dropped by RED

first-order-const

integer 0 through
100 (default 1)

Specifies the first-order constant used when
calculating drop probability based on the
average queue fraction, the queue size, and
the min-threshold value

second-order-const

integer 0 through
1000 (default 10)

Specifies the second-order constant used
when calculating drop probability based on
the average queue fraction, the queue size,
and the min-threshold value
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Version 15.2.0.0

The following section corrects the description of the Site Manager Priority
parameter, which appears in Appendix A of Configuring Differentiated Services.

Priority Parameter

The description of the Priority parameter, which appears on the COPS Server List
window, incorrectly states that the lower the number, the higher the priority. The
description should state that the higher the number, the higher the priority. For
example, a COPS server with a priority of 2 will be the active server before a
server with a priority of 1.

Version 15.3.0.0

The following section is an amendment to Chapter 2, “Starting Differentiated
Services,” in Configuring Differentiated Services.

Implementation Notes

The following guidelines can help you successfully configure DSQMS on your
router:

*  You can configure DSQMS on these interfaces only: HSSI, MCT1, MCE1,
T1/FT1, E1/FE1, and synchronous.

» Ifyou enable flow fairness on a queue, you cannot configure that queue as a
best-effort queue. For information about enabling flow fairness on a queue or
designating the queue as best effort, see “Modifying a DSQMS Queue” in
Configuring Differentiated Services.

» Ifyou configure both weighted and priority queues on an interface, you may
experience latency problems with the highest priority queues. To avoid such
problems:

— Ensure that the amount of high-priority traffic is not excessive in the
highest priority queues.
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— Set the DSQMS interface parameter dequeue-at-line-rate to enabled
(the default value is disabled). See “Configuring DSQMS to Dequeue
Packets at Line Rate” in Configuring Differentiated Services for
instructions.

Caution: Enabling the dequeue-at-line-rate parameter may cause packet loss
@ in both priority and weighted queues in certain configurations when higher
traffic levels are seen in these queues.

* Ifyouimplement RED for queue management instead of tail-drop (that is,
you set the queue parameter drop-type to red and you associate the queue
classifier with a RED function), the probability of dropping packets may
adversely affect the latency requirements of some applications. Adjust the
following parameters to achieve the required latency levels for the queue:

— RED parameters min-threshold and max-threshold (see “Modifying
RED Parameters” on page 3-1 for instructions).

— Queue parameters average-queue-gain and idle-queue-loss-rate (see
“Modifying a DSQMS Queue” in Configuring Differentiated Services for
instructions).

Version 15.4.0.0

The following section is an amendment to Chapter 2, “Starting Differentiated
Services,” in Configuring Differentiated Services.

Implementation Notes

The following guidelines can help you successfully configure DSQMS on your
router:

*  You can configure DSQMS on these interfaces only: Ethernet, HSSI, MCT1,
MCEI1, T1/FT1, E1/FE1, and synchronous.

Caution: If you configure DSQMS on an Ethernet interface that is connected

@ to an interface on a device that uses MAC addresses with leading zeros (4
bytes or more), packets may be corrupted because DSQMS interprets the zeros
as baggage and removes this baggage from the packet.
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» Ifthe Ethernet interface is connected to an external access device such as DSL
or cable modem, then Nortel Networks recommends considering policing on
the ingress interface of the router by configuring traffic filters and also
enabling the dequeue-at-line-rate parameter in DSQMS on the egress
Ethernet interface for traffic management.

» Ifyou enable flow fairness on a queue, you cannot configure that queue as a
best-effort queue. For information about enabling flow fairness on a queue or
designating the queue as best effort, see “Modifying a DSQMS Queue” in
Configuring Differentiated Services.

* Ifyou configure both weighted and priority queues on an interface, you may
experience latency problems with the highest priority queues. To avoid such
problems:

— Ensure that the amount of high-priority traffic is not excessive in the
highest priority queues.

— Set the DSQMS interface parameter dequeue-at-line-rate to enabled
(the default value is disabled). See “Configuring DSQMS to Dequeue
Packets at Line Rate” in Configuring Differentiated Services for
instructions.

Caution: Enabling the dequeue-at-line-rate parameter may cause packet loss
@ in both priority and weighted queues in certain configurations when higher
traffic levels are seen in these queues.

* Ifyou implement RED for queue management instead of tail-drop (that is,
you set the queue parameter drop-type to red and you associate the queue
classifier with a RED function), the probability of dropping packets may
adversely affect the latency requirements of some applications. Adjust the
following parameters to achieve the required latency levels for the queue:

— RED parameters min-threshold and max-threshold (see “Modifying
RED Parameters” on page 3-1 for instructions).

— Queue parameters average-queue-gain and idle-queue-loss-rate (see
“Modifying a DSQMS Queue” in Configuring Differentiated Services for
instructions).
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Version 15.5.0.0

The following section is new to Chapter 4, “Customizing Differentiated
Services,” in Configuring Differentiated Services.

DSCP Tagging for Router-Generated Packets

Beginning with Version 15.5.0.0, BayRS supports differentiated services code
point (DSCP) tagging of internally generated router packets, such as OSPF Hello
packets. This feature automatically provides differentiated services queue
management system (DSQMS) queuing for all router-generated packets based on
the internal mapping between the DSCP tag values and the DSQMS queues.

This feature enhances quality of service (QoS) on BayRS routers by marking
router-generated packets and providing the appropriate queuing treatment to
marked traffic flows by the DSQMS. This QoS enhancement provides default
settings and behaviors for different categories of network traffic based on the
Nortel Networks service class (NNSC).

Table 6-1 lists the correlation of traffic categories, Nortel Networks service
classes, and DSCPs.

Table 6-1. Correlation of Traffic Categories, Nortel Networks Service
Codes, and DiffServ Code Points
Traffic Category NNSC DSCP
Critical Control Critical CS7
Network Control Network CS6
Interactive Premium EF, CS5
Platinum AF4x, CS4
Responsive Gold AF3x, CS3
Silver AF2x, CS2
Timely Bronze AF1x, CS1
Standard DF (CS0)
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Beginning with Version 15.5.0.0, protocol packets originating from the BayRS
router are marked with the DSCP tags (markings) shown in Table 6-2. These
markings are not configurable; they are hard-coded and cannot be changed.

Table 6-2.

Mapping of BayRS Protocols and DiffServ Code Points

Traffic Category

NNSC

Network Protocol

DSCP

Scheduler

Critical Control

Critical

COPS, frame relay
LMI, LCP Echo
Request, MOSPF
Hello, OSPF Hello,
PPP LQR

CS7 (111000

Strict Priority

Network Control

Network

BGP, DVMRP, EGP,
MOSPF, OSPF,
PIM-SM, RIP, VRRP

CS6 ('110000')

Strict Priority

Responsive

Silver

BootP, DHCP,
DLSw, DNS, ICMP*,
IGMP, IPEX, NTP,
RADIUS, RSVP,
SNMP*

AF21 ('010010") |User

Configurable

Timely

Standard

FTP, IKE, HTTP,
non-|P traffic,
Telnet*, TFTP

DF (CS0)
(000000')

User
Configurable

* For additional information about ICMP, SNMP, and Telnet tagging, see “DSCP Tagging of ICMP,
SNMP. and Telnet Packets” on page 6-7.

Note: The Timely category in Table 6-2 is redundant because all packets have
a default DSCP value of CS0. However, it is included in the table to indicate
which protocols receive best-effort treatment. Packets from all network
protocols that are not included in the first three traffic categories in the table
(Critical Control, Network Control, and Responsive) are directed to the
best-effort queue, which corresponds to the Standard service class.

6-6
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DSCP Tagging of ICMP, SNMP, and Telnet Packets
This section supplements the information provided in Table 6-2.

The BayRS router tags ICMP, SNMP, and Telnet packets differently depending
on whether the router initiates the ICMP, SNMP, or Telnet session, or whether the
router is responding to packets sent to it.

*  When the router initiates an ICMP, SNMP, or Telnet connection, it tags the
packets with the DSCP specified for each protocol in Table 6-2.

*  When the router responds to incoming ICMP, SNMP, and Telnet packets, it
copies the DSCP from the incoming packets into the outgoing ICMP, SNMP,
and Telnet response packets.

Note: If the DSCP of the incoming ICMP or SNMP packet is best-effort, the
router sets the DSCP to the same value as for a router-originated ICMP or
SNMP packet.

Traffic Filters and DSCP Tagging of ICMP, SNMP, and Telnet Packets

Differentiated services traffic filters that mark incoming packets can affect the
DSCP tagging of ICMP, SNMP, and Telnet packets unless you configure the filter
to match specific criteria.

For example, assume that a traffic filter has been configured to mark all packets
traversing the router as EF. If an SNMP connection is initiated with the router and
the incoming SNMP packets are marked as AF41, the diffserv traffic filter will
mark the outgoing SNMP response packets with a DSCP of EF instead of AF41.
That is, the DSCP specified by the traffic filter will be used instead of the DSCP
in the incoming SNMP packets.

To avoid unexpected DSCP tagging of ICMP, SNMP, and Telnet packets,
configure diffserv traffic filters to match specific criteria, such as the protocol 1D
or the source or destination network. For complete information about configuring
diffserv traffic filters, see Chapter 3 of Configuring Differentiated Services.

DSCP Tagging of IPsec Packets

The DSCP in the IP headers of IPsec packets remains the same as the DSCP of the
original encapsulated IP packet. Therefore, [Psec packets are queued based on the
DSCP of the original packets and are not subject to default queue mapping.
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Mapping of Router-Generated Packets to DSQMS Queues

After they are marked with a DSCP tag, router-generated packets are mapped to
DSQMS queues based on the mapping scheme shown in the following table. As
the table indicates, critical and network control traffic is automatically directed to
the two internal queues that have strict priority scheduling.

You cannot change the mappings for the two internal queues. However, you can
override the default mappings of the user configurable queues. For information
about changing the mappings of user configurable queues, see Configuring
Differentiated Services.

Note: You should use BayRS traffic filters on untrusted ingress interfaces to
limit the critical and network control traffic entering the router. These traffic
filters minimize congestion in the high-priority internal queues.

Table 6-3. Mapping of DSQMS Queues and DSCP
Total Number of
Number of DSQMS Queues DSQMS
DSQMS Queues | (excluding the FR | Queue Differentiated Services Code
Configured Shaped Queue) Number Point (DSCP)
1 3 INTQ1 Ccs7
INTQ2 CS6
Qft CS5, EF, AFxx, CS1-4, DF (CS0)
2 4 INTQ1 Ccs7
INTQ2 CSé6
Q1 CS5, EF
Q2 AFxx, CS1-4, DF (CS0)
4 6 INTQ1 Ccs7
INTQ2 CSé
Q1 CS5, EF
Q2 AF4x, CS4
Qs AF3x, CS3
Q4 AF2x, CS2, AF1x, CS1, DF (CS0)

(continued)
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Table 6-3. Mapping of DSQMS Queues and DSCP (continued)
Total Number of

Number of DSQMS Queues DSQMS
DSQMS Queues | (excluding the FR | Queue Differentiated Services Code
Configured Shaped Queue) Number Point (DSCP)
5 7 INTQ1 Cs7

INTQ2 CS6

Q1 CS5, EF

Q2 AF4x, CS4

Qs AF3x, CS3

Q4 AF2x, CS2

Q5 AF1x, CS1, DF (CS0)
6 8 INTQ1 CS7

INTQ2 CSsé

Q1 CS5, EF

Q2 AF4x, CS4

Q3 AF3x, CS3

Q4 AF2x, CS2

Q5 AF1x, CS1

Q6 DF (CS0)

Note: INTQ1 and INTQ2 are internal queues. EF, CS5, CS4, CS3, and AF3x are DSCPs
associated with traffic types that are not router generated. This QoS enhancement deals
only with the DSCP tag values listed in Table 6-2. The other tag values are included in the
table as a reference for facilitating configuration recommendations.

To support this QoS enhancement, BCC show command statistics output is
expanded to provide additional information, as described in the next section.
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BCC show Command Enhancement

The following information supersedes that provided in Appendix C, “Using BCC
show Commands,” in Configuring Differentiated Services.

show dsqms queues stats

The BCC show dsgms queues stats command displays a table of DSQMS
queues or more specific information based on any filter argument entered, with a
subset of information from the show dsqms queues detail command. This
command displays statistics for the DSQMS configured queues and the reserved
DSQMS queues (two internal queues and the frame relay shaped queue). It is the
only command that provides any information about the DSQMS reserved queues.

This command allows the following command filter flag and argument:

-circuit <circuit_no.> Displays information about queues on the specified circuit
only.

The output now includes the new DSQMS reserved queue types added for
Version 15.5.0.0 and provides the following information:

Cct Name of the circuit

Id/Type Identification number of configured queue or type of reserved
queue

Pkt Count Number of packets queued

Byte Count Number of octets queued

Xmit Pkts Number of packets transmitted

Xmit Bytes Number of octets transmitted

Dropped Pkts Number of dropped packets

Dropped Bytes Number of dropped octets

The DSQMS reserved queue types are as follows:
e Internal Queue 1 (IntQ1)

* Internal Queue 2 (IntQ2)

*  Frame Relay Shaped Queue (FR ShQ)

6-10
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Interoperability of Protocol Prioritization (Priority Queuing) and

DSQMS

There is a common misconception that protocol prioritization (priority queuing)
and DSQMS cannot co-exist. On the contrary, these two features can be
configured at the same time. In fact, there are situations when DSQMS is
configured in which protocol prioritization also must be configured, such as in the
case of prioritizing the frame relay Local Management Interface (LMI) traffic into
IntQ1. The same situation also applies when prioritizing PPP Link Quality Report
(LQR) packets and Link Control Protocol (LCP) echo requests.

The interoperability of these two features can be summarized as follows:

DSQMS operates at the driver level only.

When frame relay is configured, protocol prioritization operates at the driver
level as well as at the frame relay level.

When both protocol prioritization and DSQMS are configured, at the driver
level DSQMS always takes precedence. This means that such a configuration
is inconsequential as far as protocol prioritization is concerned because at the
driver level, DSQMS will be running.

When both protocol prioritization and DSQMS are configured, at the frame
relay level only protocol prioritization operates (because DSQMS operates
only at the driver level). BayRS code (even before the DSCP tagging feature
was available) tags frame relay LMI as interrupt traffic only if protocol
prioritization is configured. So, the purpose of protocol prioritization
configuration for LMI is only to tag packets (in the frame relay code) so they
can be identified later (in the driver code). When a tagged LMI packet comes
to the driver, the following occurs:

*  When DSQMS is not configured, protocol prioritization operates at the
driver level. In this case, protocol prioritization identifies the tag and puts
the LMI traffic into the Interrupt Queue.

*  When DSQMS is configured, it takes precedence over protocol
prioritization. In this case, DSQMS identifies the tag and puts the LMI
traffic into Internal Queue 1 (IntQ1).

314470-15.7 Rev 00
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Version 15.6.0.0

The following sections contain additions and amendments to Configuring

Differentiated Services (part number 308620-14.20 Rev 00).

Topic Page
Mapping of Router-Generated Protocol Packets to DSCPs 6-12
Interoperability of Protocol Prioritization and DSQMS 6-13
Using Site Manager to Configure DSQMS 6-14

Mapping of Router-Generated Protocol Packets to DSCPs

The DSCPs for several protocols have been changed for Version 15.6.0.0. The
following section revises Table 6-2 on page 6-6. For complete information about

DSCP tagging of router-generated packets, see

3

Router-Generated Packets” on page 6-5.

“DSCP Tagging

ing for

Beginning with Version 15.6.0.0, protocol packets originating from the BayRS
router are marked with the DSCP tags (markings) shown in Table 6-4. (These
markings are not configurable; they are hard-coded and cannot be changed.)

Table 6-4. Mapping of BayRS Protocols to DSCPs
Traffic Category |NNSC Network Protocol |DSCP Scheduler
Critical Control Critical COPS, frame relay |CS7 (‘111000") | Strict Priority
LMI, LCP Echo
Request, MOSPF
Hello, OSPF Hello,
PPP LQR
Network Control Network BGP, BootP, DHCP, |CS6 ('110000") Strict Priority
DNS, DVMRP, EGP,
MOSPF, OSPF,
PIM-SM, RIP, VRRP
Interactive Platinum | IPEX AF41 ('100010") |User
Configurable
Responsive Silver DLSw, ICMP*, AF21 ('010010') |User
IGMP, NTP, Configurable
RADIUS, RSVP
(continued)
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Table 6-4. Mapping of BayRS Protocols to DSCPs (continued)
Traffic Category |NNSC Network Protocol |DSCP Scheduler
Timely Bronze SNMP* AF11 ('001010") |User
Configurable
Standard |FTP, IKE, HTTP, DF (CS0) User
non-IP traffic, ('000000") Configurable
Telnet*, TFTP

* For additional information about ICMP, SNMP, and Telnet tagging, see “DSCP Tagging of ICMP,
SNMP, and Telnet Packets” on page 6-7.

Note: The Timely-Standard category in Table 6-4 is redundant because all
nd packets have a default DSCP value of CS0. However, it is included in the table
to indicate which protocols receive best-effort treatment. Packets from all
network protocols that are not included in any other traffic category in the
table (Critical Control, Network Control, Interactive, and Responsive) are
directed to the best-effort queue, which corresponds to the Standard service
class.

Interoperability of Protocol Prioritization and DSQMS

The interoperability of protocol prioritization (priority queuing) and DSQMS has
changed for Version 15.6.0.0. This section updates the information in
“Interoperability of Protocol Prioritization (Priority Queuing) and DSQMS” on

page 6-11.

With Version 15.6.0.0, DSQMS operates at the driver level and at the frame relay
level to allow DSQMS to be used as the QoS mechanism at the frame relay level.
In earlier versions of BayRS, only protocol prioritization operated at the frame
relay level, even if DSQMS was configured at the interface level.

= | Note: For more information about frame relay traffic shaping using DSQMS,
see “‘Frame Relay Traffic Shaping with DSQMS” on page 9-5.

The treatment of the following traffic is the same as in earlier versions of BayRS:
frame relay Local Management Interface (LMI) traffic and PPP Link Quality
Report (LQR) packets and Link Control Protocol (LCP) echo requests.
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BayRS tags frame relay LMI as interrupt traffic only if protocol prioritization is
configured. So, the purpose of protocol prioritization configuration for LMI is
only to tag packets (in the frame relay code) so they can be identified later (in the
driver code). When a tagged LMI packet comes to the driver, the following
occurs:

*  When DSQMS is not configured, protocol prioritization operates at the driver
level. In this case, protocol prioritization identifies the tag and puts the LMI
traffic into the Interrupt Queue.

*  When DSQMS is configured, it takes precedence over protocol prioritization.
In this case, DSQMS identifies the tag and puts the LMI traffic into Internal
Queue 1 (IntQ1).

Using Site Manager to Configure DSQMS

The following section supplements Chapter 2, “Starting Differentiated Services,”
and Chapter 6, “Customizing Queue Management and Scheduling,” in
Configuring Differentiated Services (part number 308620-14.20 Rev 00).

Beginning with Version 15.6.0.0, you can use Site Manager to configure DSQMS
on the router. Before Version 15.6.0.0, you could only use the BCC to configure
DSQMS.

Note: Using Site Manager, you can configure DSQMS on PPP multiline and
multilink bundles. (The BCC does not support multiline or multilink
configuration.) However, DSQMS traffic shaping is not supported on frame
relay multiline/multilink.

For an overview of queue management and scheduling, see the following sections
in Configuring Differentiated Services.

*  “Queue Management and Scheduling (QMS)” in Chapter 1
*  “How DSQMS Elements Work Together” in Chapter 2

Also, see the earlier sections of this chapter in the Document Change Notice,
especially “Implementation Notes” on page 6-3.

6-14
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DSQMS Configuration Steps

To start DSQMS on the router, perform the following steps. These steps are
described in the following sections.

1. Ifnecessary, configure a circuit on a slot and connector.

2.  Enable DSQMS on the circuit.

= | Note: For frame relay circuits, you enable DSQMS on the default service
record only. You cannot enable DSQMS on any other service record.

3. Create one or more sets of RED attributes that can be used by queues on the
interfaces.

4. Create one or more queues on the interface.

5. Create one or more traffic classifiers on each queue.

For information and instructions on configuring a circuit on a slot and connector,
see Configuring WAN Line Services or Configuring Ethernet, FDDI, and Token
Ring Services.

Enabling DSQMS on an Interface

After you successfully configure a new circuit, the Select Protocols window
opens. Proceed as follows:

Site Manager Procedure

You do this System responds
1. In the Select Protocols window, select
DSQMS.
2. Click on OK. The Edit DSQMS Parameters window
opens.
3. If necessary, set the following parameters:
¢ Debug Level
* Dequeue At Line Rate
Click on Help or see the parameter
descriptions beginning on page A-18.
4. Click on Apply then click on Done. You return to the Configuration Manager
window.
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Creating RED Instances for Use by Traffic Classifiers

Each instance of DSQMS RED defines a set of attributes for use in traffic
classifiers that are associated with DSQMS queues. To create RED instances,

perform the following steps:

Site Manager Procedure

You do this

System responds

1. In the Configuration Manager window,
choose Protocols.

The Protocols menu opens.

Set the following parameters:

¢ First Order Const

e Second Order Const

¢ Min Threshold

¢ Max Threshold

Click on Help or see the parameter
descriptions beginning on page A-15.

2. Choose DSQMS. The DSQMS menu opens.

3. Choose RED. The Edit RED Parameters window opens.
4. Click on Add.

5.

6. Click on Apply then click on Done.

steps 4 through 6.

7. To configure more RED instances, repeat

8. Click on Done.

You return to the Configuration Manager
window.

Creating DSQMS Queues and Associated Traffic Classifiers

To create a DSQMS queue and its associated traffic classifiers, perform the

following steps:

Site Manager Procedure

You do this

System responds

1. In the Configuration Manager window,
choose Protocols.

The Protocols menu opens.

2. Choose DSQMS.

The DSQMS menu opens.

(continued)
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Site Manager Procedure (continued)
You do this System responds
3. Choose Interface. The Edit DSQMS Parameters window
opens.
4. Click on Queues. The Edit DSQMS Queue List window
opens.
5. Click on Add. The Edit DSQMS Parameters window
opens.
6. Set the Enable parameter to Enable.
Click on Help or see the parameter
description on page A-20.
7. Set other queue parameters as needed.
Click on Help or see the parameter
descriptions beginning on page A-20.
8. Click on OK. You return to the Edit DSQMS Queue List
window.
9. To configure a traffic classifier for the The Edit DSQMS Classifier List window
queue, click on Classifier. opens.
10. Click on Add. The Classifier ID Selection window
opens.
11. Type an 8-digit (binary octet) DSCP. See
the parameter description on page A-26.
12. Click on OK. You return to the Edit DSQMS Classifiers
window opens.
13. Set the following parameters:
¢ Classifier Queue ID
e Classifier RED ID
Click on Help or see the parameter
descriptions beginning on page A-26.
14. Click on Done. You return to the Edit DSQMS Classifier
List window.
15. To configure more classifiers, repeat steps
9 through 14.
16. Click on Done. You return to the Edit DSQMS Queue List
window.
17. To configure more queues, repeat steps 5
through 16.

(continued)

314470-15.7 Rev 00

6-17



BayRS Version 15.7.0.0 Document Change Notice

Site Manager Procedure (continued)

You do this

System responds

18. Click on Done.

You return to the Edit DSQMS
Parameters window.

19. Click on Done.

You return to the Configuration Manager
window.

Modifying RED Parameters

You can modify parameters for an instance of DSQMS RED. To edit an RED

instance, perform the following steps:

Site Manager Procedure

You do this

System responds

1. In the Configuration Manager window,
choose Protocols.

The Protocols menu opens.

2. Choose DSQMS.

The DSQMS menu opens.

3. Choose RED.

The Edit RED Parameters window opens.

4. Select the RED instance that you want to

edit.

5. Edit one or more of the following
parameters:
¢ Second Order Const
* First Order Const
* Min Threshold
¢ Max Threshold
Click on Help or see the parameter
descriptions beginning on page A-15.

6. Click on Apply then click on Done.

You return to the Configuration Manager
window.
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Modifying DSQMS Interface Parameters

You can modify DSQMS parameters for an interface. To edit DSQMS interface
parameters, perform the following steps:

Site Manager Procedure

You do this

System responds

1.

In the Configuration Manager window,
choose Protocols.

The Protocols menu opens.

Choose DSQMS.

The DSQMS menu opens.

3. Choose Interface.

The Edit DSQMS Parameters window
opens.

Select the interface that you want to edit.

Edit one or more of the following
parameters:

¢ Enable

¢ Debug Level

¢ Dequeue At Line Rate

Click on Help or see the parameter
descriptions beginning on page A-17.

Click on Apply.

Click on Restart.

When you edit parameters for a DSQMS
interface, you must restart DSQMS on the
interface for the changes to take effect.

Click on Done.

You return to the Configuration Manager
window.
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Modifying DSQMS Queues

You can modify DSQMS queues on an interface. To edit DSQMS queue
parameters, perform the following steps:

Site Manager Procedure

You do this

System responds

1.

In the Configuration Manager window,
choose Protocols.

The Protocols menu opens.

Choose DSQMS.

The DSQMS menu opens.

3. Choose Interface.

The Edit DSQMS Parameters window
opens.

Select the interface that has the DSQMS
queue that you want to edit.

Click on Queues.

The Edit DSQMS Queue List window
opens.

Select the queue that you want to edit.

Edit queue parameters as needed.
Click on Help or see the parameter
descriptions beginning on page A-20.

Click on Apply and then click on Done.

You return to the Edit DSQMS
Parameters window.

Click on Restart.

When you edit parameters for a DSQMS
queue, you must restart DSQMS on the
interface for the changes to take effect.

10. Click on Done.

You return to the Configuration Manager
window.

6-20
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Chapter 7
Configuring DLSw Services

Version 15.5.0.0

The following section supplements Chapter 4, “Customizing DLSw Services,” in
Configuring DLSw Services.

DLSw Protocol Prioritization

DLSw protocol prioritization is an outbound filtering mechanism that enables you
to assign preference to specific types of traffic supported by DLSw. DLSw
protocol prioritization does not affect traffic as it enters the router, but affects the
sequence in which traffic exits the router.

Prior to Version 15.5.0.0, only Site Manager could be used to configure DLSw
protocol prioritization. The following sections explain how to use the BCC to
configure this feature. For general information on DLSw protocol prioritization
and for information on using Site Manager to configure it, see Configuring DLSw
Services.
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Configuring DLSw Protocol Prioritization using the BCC

Note: This section assumes that DLSw is already configured on an interface
and that the peer table is complete. For information about configuring a circuit
with DLSw and setting the slot, peer, and SAP parameters, refer to
Configuring DLSw Services.

There are three parts to configuring DLSw protocol prioritization using the BCC:
*  Configuring and enabling global parameters for DLSw protocol prioritization
* Customizing and enabling DLSw priority queues for specific DLSw peers

*  Creating and enabling priority outbound filters for DLSw traffic

Configuring and Enabling Global Parameters for DLSw Protocol
Prioritization

DLSw protocol prioritization is disabled by default. When you enable it, it takes
effect using the currently configured values (default or customized) for all global
DLSw protocol prioritization parameters. You can customize the DLSw protocol
prioritization configuration to meet the specific needs of your site by changing the
default settings of the global DLSw protocol prioritization parameters.

Customizing Global Parameters for DLSw Protocol Prioritization

To meet the specific needs of your site, you can modify the default settings of one
or more of the following DLSw protocol prioritization global parameters:

* max-queue-buffers-unconfig-peers—specifies the maximum number of
packets in each queue

*  max-queue-size-unconfig-peers—specifies the maximum size (in bytes) of
each queue

* default-bandwidth—specifies the number of queues to be used and allocates
the bandwidth for each

max-queue-buffers-unconfig-peers

To specify the maximum number of packets in each queue, navigate to the
dlsw-protocol-prioritization prompt (for example, box; disw;
disw-protocol-prioritization) and enter:

7-2
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max-queue-buffers-unconfig-peers <value>

value is an integer between 10 and 2147483647, inclusive. The default value is
50.

For example, to specify 100 as the maximum number of packets in each default
queue, enter:

dlsw-protocol-prioritization# max-queue-buffers-unconfig-peers 100
dlsw-protocol-prioritization#

max-queue-size-unconfig-peers

To specify the maximum size (in bytes) of each default queue, navigate to the
dlsw-protocol-prioritization prompt (for example, box; disw;
disw-protocol-prioritization) and enter:

max-queue-size-unconfig-peers <value>

value is an integer between 5,000 and 2,147,483,647, inclusive. The default value
is 16000.

For example, to specify 18000 as the maximum number of packets in each default
queue, enter:

dlsw-protocol-prioritization# max-queue-size-unconfig-peers 18000

dlsw-protocol-prioritization#

default-bandwidth

To specify the number of default queues to be used and allocate the bandwidth for
each, navigate to the dlsw-protocol-prioritization prompt (for example, box;
disw; disw-protocol-prioritization) and enter:

default-bandwidth <value>

value is the allocated bandwidth for each of the 10 default priority queues (0-9).
The default value is {60, 40, 0, 0, 0, 0, 0, 0, 0, 0}. Thus, the default setting utilizes
only two priority queues by allocating 60% for queue 0, 40% for queue 1, and 0%
for each of the remaining 8 queues. A valid value is any combination of 10 entries
that add up to 100. Each entry represents the allocated bandwidth percentage for
one of the 10 queues (0 through 9). You must enter a value for each of the 10
queues. The sum of the specified bandwidth percentages must equal 100.
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For example, to allocate 10 percent of the bandwidth to each of the 10 queues,
navigate to the dlsw-protocol-prioritization prompt (for example, box; disw;
disw-protocol-prioritization) and enter:

dlsw-protocol-prioritization# default-bandwidth {10 101010101010
101010}

dlsw-protocol-prioritization#

For example, to allocate 40 percent of the bandwidth to queue 0, 30 percent of the
bandwidth to queue 1, and 30% of the bandwidth to queue 3, navigate to the
dlsw-protocol-prioritization prompt (for example, box; disw;
disw-protocol-prioritization) and enter:

dlsw-protocol-prioritization# default-bandwidth {403030000000 0}

dlsw-protocol-prioritization#

Enabling and Disabling DLSw Protocol Prioritization for Peers

When you enable DLSw protocol prioritization, it takes effect using the currently
configured values (default or customized) for the global parameters.

Enabling DLSw protocol prioritization for configured peers

To enable DLSw protocol prioritization for configured peers, navigate to the
global dlsw prompt (for example, box; dlsw) and enter:

disw-protocol-prioritization protocol-priority enabled

For example, to enable DLSw protocol prioritization for configured peers using
the currently configured values for the global DLSw protocol prioritization
parameters, navigate to the global dlsw prompt and enter:

dlsw# dlsw-protocol-prioritization protocol-priority enabled
dlsw-protocol-prioritization#

The default setting for protocol-priority is disabled. To disable DLSw protocol
prioritization for configured peers after enabling it, navigate to the global dlsw
prompt and enter:

disw-protocol-prioritization protocol-priority disabled
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Enabling DLSw protocol prioritization for unconfigured peers

To enable DLSw protocol prioritization for unconfigured peers using the currently
configured values (default or customized) for the global DLSw protocol
prioritization parameters, navigate to the global dlsw prompt (for example, box;
disw) and enter:

disw-protocol-prioritization pp-unconfigured-peers enabled

For example, to enable DLSw protocol prioritization for unconfigured peers using
the currently configured values for the global DLSw protocol prioritization
parameters, navigate to the global dlsw prompt and enter:

disw# dlsw-protocol-prioritization pp-unconfigured-peers enabled

dlsw-protocol-prioritization#

The default setting for pp-unconfigured-peers is disabled. To disable DLSw
protocol prioritization for unconfigured peers after enabling it, navigate to the
global dlsw prompt and enter:

disw-protocol-prioritization pp-unconfigured-peers disabled

Customizing and Enabling DLSw Priority Queues for Specific Peers
You can fine tune DLSw priority queues for a specific peer by performing the
following tasks:

*  Specify a peer for custom DLSw priority queue configuration.
*  Customize the DLSw priority queue parameters for the specified peer.

* Enable the specified peer’s custom DLSw priority queue configuration.

= | Note: Peer-specific priority queue configurations take precedence over any
currently enabled global DLSw protocol prioritization queue configuration.

Specifying a Peer for Custom DLSw Priority Queue Configuration

To specify a peer for custom DLSw priority queue configuration, navigate to the
global dlsw prompt (for example, box; disw) and enter:

peer-queue-configuration peer-ip-addr <value>
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value is the IP address of the peer for which you want to configure custom DLSw
priority queues.

For example, to specify custom DLSw priority queue configuration for a peer
with an IP address of 192.168.1.1, enter:

dlsw# peer-queue-configuration peer-ip-addr 192.168.1.1
dlsw-peer-queue-configuration/192.168.1.1#

Customizing the DLSw Priority Queues for a Specific Peer

For a specified peer, you can override the currently configured global DLSw
protocol prioritization parameters for the following elements:
*  maximum buffer size for each queue

*  maximum number of packets per queue

» allocated bandwidth for each of the 10 DLSw priority queues (0-9)

max-queue-buffers

To specify the maximum number of packets for each of a peer’s DLSw priority
queues, navigate to the peer’s dlsw-peer-queue-configuration prompt (for
example, box; dlsw; dlsw-peer-queue-configuration/<peer-IP-address>) and
enter:

max-queue-buffers <value>

value is the maximum number of packets allowed in each of this peer’s priority
queues. The range of valid values is from 10 to 2147483647, inclusive. The
default is 50.

For example, to specify 200 as the maximum number of packets in each of the
DLSw priority queues for a peer with an IP address of 192.168.1.1, navigate to the
peer’s dlsw-peer-queue-configuration prompt and enter:

dlsw-peer-queue-configuration/192.168.1.1# max-queue-buffers 200
dlsw-peer-queue-configuration/192.168.1.1#

bandwidth-allocation

To allocate the bandwidth for each of the peer’s 10 DLSw priority queues, first
navigate to the peer’s dlsw-peer-queue-configuration prompt (for example, box;
disw; disw-peer-queue-configuration/<peer-IP-address>) and enter:
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bandwidth-allocation

This action displays the bandwidth-allocation/<peer-IP-address> prompt for the
peer.

At the bandwidth-allocation/<peer-IP-address> prompt for the peer, enter:

disw-queue <value>

value is the allocated bandwidth for each of the 10 DLSw priority queues (0-9).
The default value is {60, 40, 0, 0, 0, 0, 0, 0, 0, 0}. A valid value is any
combination of 10 entries that add up to 100. Each entry represents the allocated
bandwidth percentage for one of the 10 queues (0 through 9). You must enter a
value for each of the 10 queues. The sum of the specified bandwidth percentages
must equal 100.

For example, to allocate 10 percent of the bandwidth to each of the 10 queues,
navigate to the peer’s bandwidth-allocation prompt and enter:

bandwidth-allocation/192.168.1.1# dlsw-queue {10101010101010 10
10 10}
bandwidth-allocation/192.168.1.1#

max-queue-size

To specify the maximum size (in bytes) of each queue for a peer, navigate to the
peer’s dlsw-peer-queue-configuration prompt (for example, box; disw;
disw-peer-queue-configuration/<peer-IP-address>) and enter:

max-queue-size <value>

value is the maximum size (in bytes) for each of this peer’s priority queues. The
range of valid values is from 5000 to 2147483647, inclusive. The default is
16000.

For example, to specify 20000 as the maximum number of packets allowed in
each DLSw priority queue for a peer with an [P address of 192.168.1.1, navigate
to the peer’s dlsw-peer-queue-configuration prompt and enter:

dlsw-peer-queue-configuration/192.168.1.1# max-queue-size 20000
dlsw-peer-queue-configuration/192.168.1.1#
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Enabling and Disabling a Peer’s DLSw Priority Queues

Peer-specific DLSw priority queues are disabled by default. To enable the
customized DLSw priority queues that you have configured for a specific peer,
navigate to the peer’s dlsw-peer-queue-configuration prompt (for example, box;
disw; disw-peer-queue-configuration/<peer-IP-address>) and enter:

protocol-priority enabled

For example, to enable the customized DLSw priority queues that you configured
for a peer with an IP address of 192.168.1.1, navigate to the peer’s
dlsw-peer-queue-configuration prompt and enter:

dlsw-peer-queue-configuration/192.168.1.1# protocol-priority enabled
dlsw-peer-queue-configuration/192.168.1.1#

To disable the customized DLSw priority queues for a specific peer again,
navigate to the peer’s dlsw-peer-queue-configuration prompt (for example, box;
disw; dlsw-peer-queue-configuration/<peer-IP-address>) and enter:

protocol-priority disabled

For example, to disable the customized DLSw priority queues for a peer with an
IP address of 192.168.1.1, navigate to the peer’s dlsw-peer-queue-configuration
prompt and enter:

dlsw-peer-queue-configuration/192.168.1.1# protocol-priority disabled
dlsw-peer-queue-configuration/192.168.1.1#

Creating and Enabling Priority Outbound Filters for DLSw traffic

You can create priority filters for outbound DLSw traffic for specific peers that
determine which traffic is sent to which DLSw priority queue (0 through 9).

To create a DLSw priority filter for outbound traffic, navigate to the global dlsw
prompt (for example, box; dlsw) and enter:

disw-priority-outbound-filter-name <filter_name> peer-ip-addr <value>

filter_name is a descriptive name of the outbound traffic filter you are creating.
For example, use the name dsap _0land02 g3 for a filter that sends traffic with a
destination SAP address of 01 or 02 to queue 3. The filter name can be up to 30
alphanumeric characters in length.
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value is the IP address of the peer for which you are creating the filter.

For example, to create a DLSw outbound filter named dsap 01and02 g3 for a
DLSw peer with an IP address of 192.168.1.1, navigate to the global dlsw prompt
(for example, box; dlsw) and enter:

disw-priority-outbound-filter-name dsap_01t002_q3 peer-ip-addr
192.168.1.1

Enabling and Disabling DLSw Outbound Filters

By default, an outbound filter is enabled when you create it.

Disabling an Outbound Filter

To disable a DLSw priority filter, navigate to the peer’s filter prompt (for
example, box; dlsw; dlsw-priority-outbound-filter/<filter_name>/
<peer_address>) and enter:

state disabled

For example, to disable a DLSw outbound filter named dsap 0land02 g3 for a
peer with an IP address of 192.168.1.1, navigate to the peer’s filter prompt (box;
disw; disw-priority-outbound-filter/dsap_01and02_q3/192.168.1.1) and enter:

dlsw-priority-outbound-filter/dsap_0land02_g3/192.168.1.1# state
disabled

dlsw-priority-outbound-filter/dsap_0land02_g3/192.168.1.1#

Enabling an Outbound Filter

To enable a DLSw priority filter again, navigate to the peer’s filter prompt (for
example, box; disw; disw-priority-outbound-filter/<filter_name>/
<peer_address>) and enter:

state enabled

For example, to enable a DLSw outbound filter named dsap 0land02 g3 for a
peer with an IP address of 192.168.1.1, navigate to the peer’s filter prompt (box;
disw; disw-priority-outbound-filter/dsap_01and02_q/192.168.1.1) and enter:

dlsw-priority-outbound-filter/dsap_0land02_qg/192.168.1.1# state
enabled
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dlsw-priority-outbound-filter/dsap_0land02_qg/192.168.1.1#

Specifying Match Criteria for DLSw Priority Outbound Filters

For DLSw priority outbound filters, you can specify SAP source and destination
addresses and MAC source and destination addresses as match criteria. Traffic
that matches the configured match criteria for a filter is handled according to the
configured filter actions.

Note: The BCC does not support the use of predefined match criteria for FID2
and FID4 frames in DLSw outbound filters in Version 15.5.0.0, or earlier.
However, Site Manager supports the use of these predefined match criteria.

To prepare to specify the filtering match criteria, navigate to the peer’s filter
prompt (for example, box; dlsw; disw-priority-outbound-filter/ <filter_name>/
<peer_address>, and enter:

match

This action displays the priority outbound filter’s match prompt. For example, to
display the match prompt for a filter named dsap 01and02 g3 for a peer with an
IP address of 192.168.1.1, navigate to the peer’s filter prompt (box; disw;
disw-priority-outbound-filter/dsap_01and02_q3/192.168.1.1) and enter:

dlsw-priority-outbound-filter/dsap_0land02_g3/192.168.1.1# match

match/dsap_0land02_qg3/192.168.1.1#

Specifying MAC destination addresses

To specify a MAC destination address as a filter criteria, navigate to the peer
filter’s match prompt, (for example, box; disw; dlsw-priority-outbound-filter/
<filter_name>/ <peer_address>; match), and enter:

pri-dlsw-mac-dest-addr <address_range>

<address_range> is the range of MAC destination addresses for the filter in
hexadecimal notation. Valid values are in the range of O-FFFFFFFFFFFF,
inclusive. For a range with only one value, enter only one MAC destination
address. The BCC automatically uses that value for both the minimum and
maximum values in the address range.
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For example, to specify a range of MAC destination addresses from Oaaa to Oaab
as a match criteria for a filter named dsap 0land02 g3 for a peer with an IP
address of 192.168.1.1, navigate to the filter’s match prompt, (box; disw;
disw-priority-outbound-filter/dsap_01and02_q3/192.168.1.1; match), and
enter:

match/dsap_0land02_g3/192.168.1.1#% pri-dlsw-mac-dest-addr {0aaa-0aab}

match/dsap_0land02_qg3/192.168.1.1#

Specifying MAC source addresses

To specify a MAC source address as a filter criteria, navigate to the peer filter’s
match prompt, (for example, box; dlsw; disw-priority-outbound-filter/
<filter_name>/ <peer_address>; match), and enter:

pri-dilsw-mac-src-addr <address_range>

<address_range> is the range of MAC destination addresses for the filter in
hexadecimal notation. Valid values are in the range of O-FFFFFFFFFFFF,
inclusive. For a range with only one value, enter only one MAC source address.
The BCC automatically uses that value for both the minimum and maximum
values in the address range.

For example, to specify a range of MAC source addresses from 0000a2000001 to
000022000003 as a match criteria for a filter named dsap 0land(02 g3 for a peer
with an [P address of 192.168.1.1, navigate to the filter’s match prompt, (box;
disw; disw-priority-outbound-filter/dsap_01and02_q3/192.168.1.1; match),
and enter:

match/dsap_0land02_g3/192.168.1.1# pri-dlsw-mac-src-addr
{0000a2000001-0000a2000003}

match/dsap_0land02_g3/192.168.1.1#

Specifying SAP destination addresses

To specify a SAP destination address as a filter criteria, navigate to the peer
filter’s match prompt, (for example, box; dlsw; dlsw-priority-outbound-filter/
<filter_name>/ <peer_address>; match), and enter:

pri-disw-dsap <address_range>
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<address_range> is the range of SAP destination addresses for the filter. Valid
values are in the range of 0-65535, inclusive. For a range with only one value,
enter only one SAP destination address. The BCC automatically uses that value
for both the minimum and maximum values in the address range.

For example, to specify a range of SAP destination addresses from 1 to 2 as a
match criteria for a filter named dsap 01and02 g3 for a peer with an IP address
of 192.168.1.1, navigate to the filter’s match prompt, (box; disw;
disw-priority-outbound-filter/dsap_01and02_q3/192.168.1.1; match), and
enter:

match/dsap_0land02_g3/192.168.1.1# pri-dlsw-dsap {1-2}

match/dsap_0land02_g3/192.168.1.1#

Specifying SAP source addresses

To specify a SAP source address as a filter criteria, navigate to the peer filter’s
match prompt, (for example, box; disw; disw-priority-outbound-filter/
<filter_name>/ <peer_address>; match), and enter:

pri-dlsw-ssap <address_range>

<address_range> is the range of SAP source addresses for the filter. Valid values
are in the range of 0-65535, inclusive. For a range with only one value, enter only
one SAP source address. The BCC automatically uses that value for both the
minimum and maximum values in the address range.

For example, to specify a range of SAP source addresses from 4 to 5 as a match
criteria for a filter named dsap 0land02 g3 for a peer with an IP address of
192.168.1.1, navigate to the filter’s match prompt, (box; disw;
disw-priority-outbound-filter/dsap_01and02_qg3/192.168.1.1; match), and
enter:

match/dsap_0land02_qg3/192.168.1.1# pri-dlsw-ssap {4-5}
match/dsap_0land02_g3/192.168.1.1#
Specifying the Action for DLSw Priority Outbound Filters

You can specify the following actions for DLSw priority outbound filters:

* queue—specifies to which DLSw priority queue (0-9) traffic that matches the
filter’s match criteria will be sent
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* action-log—specifies whether the router will send an entry to the system log
file for traffic that matches the filter’s match criteria

To prepare to specify the filter action, navigate to the peer’s filter prompt (for
example, box; disw; disw-priority-outbound-filter/ <filter_name>/
<peer_address>, and enter:

actions

This action displays the priority outbound filter’s actions prompt. For example, to
display the actions prompt for a filter named dsap 01and02 g3 for a peer with an
IP address of 192.168.1.1, navigate to the peer’s filter prompt (box; disw;
disw-priority-outbound-filter/dsap_01and02_q3/192.168.1.1) and enter:

dlsw-priority-outbound-filter/dsap_0land02_qg3/192.168.1.1# actions

actions/dsap_0land02_g3/192.168.1.1#

Specifying the Queue Action

To specify the priority queue for traffic that matches the filter’s match criteria,
navigate to the peer filter’s actions prompt, (for example, box; disw;
disw-priority-outbound-filter/ <filter_name>/ <peer_address>; actions), and
enter:

queue <value>

<value> is the number of the DLSw priority queue for this filter. Valid values are
from 0 to 9, inclusive.

For example, to specify queue 1 as the priority queue for a filter named

dsap 0land02 q3 for a peer with an IP address of 192.168.1.1, navigate to the
filter’s actions prompt, (box; disw; dlsw-priority-outbound-filter/
dsap_01and02_q3/192.168.1.1; actions), and enter:

actions/dsap_0land02_g3/192.168.1.1# queue 1

actions/dsap_0land02_g3/192.168.1.1#
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Specifying the Log Action

To specify the log action for traffic that matches the filter’s match criteria,
navigate to the peer filter’s actions prompt, (for example, box; disw;
disw-priority-outbound-filter/ <filter_name>/ <peer_address>; actions), and
enter:

action-log {on | off}

on (the default) indicates that when an outbound packet matches the filter’s match
criteria, the DLSw outbound priority filter adds an entry to the system log file.

off specifies that no DLSw outbound priority filter information is written to the
system event log file.

For example, to turn off logging for a filter named dsap 01and02 g3 for a peer
with an IP address of 192.168.1.1, navigate to the filter’s actions prompt, (box;
disw; disw-priority-outbound-filter/dsap_01and02_q3/192.168.1.1; actions),
and enter:

actions/dsap_0land02_g3/192.168.1.1# action-log off

actions/dsap_0land02_qg3/192.168.1.1#

For example, to turn logging on again for a filter named dsap 0land(2 g3 for a
peer with an [P address of 192.168.1.1, navigate to the filter’s actions prompt,
(box; disw; disw-priority-outbound-filter/dsap_01and02_g3/192.168.1.1;
actions), and enter:

actions/dsap_0land02_g3/192.168.1.1# action-log on

actions/dsap_0land02_g3/192.168.1.1#
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Chapter 8
Configuring Ethernet, FDDI, and Token Ring
Services

Version 15.4.0.0

The following section is new to Chapter 2 of Configuring Ethernet, FDDI, and
Token Ring Services.

The sections “Router Processing of Tagged Frames,” “Implementation
Considerations,” “Adding a Tagged Circuit to an Unconfigured 10BASE-T or
100BASE-T Interface,” and “Adding a Tagged Circuit to an Existing 10BASE-T
or 100BASE-T Interface” contain amendments to Chapter 5 of Configuring
Ethernet, FDDI, and Token Ring Services.

Router Processing of Tagged Frames

802.1Q tagging is supported on 10BASE-T and 100BASE-T interfaces that
connect the Nortel Networks router to an 802.1Q-compliant switch or routing
switch. With 802.1Q tagging enabled, the physical connection between the router
and the adjacent device supports multiple virtual connections.

The number of connections is equal to the number of virtual connections plus a
default physical connection that provides transit services for other non-VLAN
traffic that may be received from or forwarded to the adjacent device.

Upon receipt of a frame across a virtual connection, a circuit manager strips the
four bytes of 802.1Q header information and directs a now standard Ethernet
frame to a connection-specific routing process. The routing process consults its
forwarding table and, in turn, directs the frame to a circuit manager handling the
next-hop connection. If that connection is a non-tagged, non-virtual connection,
processing is completed as for any other standard Ethernet frame.
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However, if the next-hop connection is a tagged, virtual connection, the circuit
manager inserts the four bytes of 802.1Q header information that identify that
VLAN into the standard Ethernet header. After performing the 802.1Q
encapsulation, the circuit manager forwards the frame across the virtual
connection toward the destination VLAN.

Implementation Considerations
Before you configure 802.1Q tagging on a router, note the following
considerations:

*  802.1Q tagging is supported on 10BASE-T and 100BASE-T interfaces; it is
not supported on other LAN interfaces.

*  802.1Q tagging cannot be used to extend a VLAN across multiple devices.

» The VLAN type (port-based, protocol-based, address-based, and so on) is
ignored by the router.

Table 8-1 lists the platform modules that support 802.1Q tagging.

Table 8-1. Supported Modules for 802.1Q Tagging

Platform Ethernet Interface Type

Passport 2430 10/100 Base Unit